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22 Shop Like a Pro

Shop smart! We tell you which specs to
scrutinize, which features to ignore, and
what to ask the salesperson when you’re
buying cameras, printers, hard drives,
and more. Plus, we recommend the best
products based on quality, value, and
style. by Roman Loyola, Rik Myslewski,
Rick Oldano, and Andrew Tokuda

31 Surprise!

How well do you really know your best digital pal? Here are nine things you may not know your
Mac can do. by Niko Coucouvanis, Logan Kugler, and Rik Myslewski

38 Command Key
Key Commands

Mouse, schmouse—use our handy list of 108 Microsoft
Word–wrangling key commands to let your keyboard do
the clicking. by Rik Myslewski

how to
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68 Ask Us

74 Tee Up Your Photos

We show you how to rip audiobook CDs for
listening on your iPod, how to FTP securely,
how to use movies as screen savers, and more.
Why? Because we love you.

Blank T-shirts are for people with blank minds,
so spice up your shirt with your favorite
photo, logo, graphic, or dirty word.
by Niko Coucouvanis

70 Make a Stop-Motion Video

78 Trick Out iTunes 7

Remember the
California Raisins?
You can do better
than that. We show
you how to make your
own animations with
iStopMotion. by Brian Moore

Albums and podcasts
and movies, oh my!
We help you keep your
head above the evergrowing ocean of your
iTunes library.
by Niko Coucouvanis

COVER PHOTOGRAPHS BY MARK MADEO

You don’t put limits on your creativity.
(Why should your technology?)

Apple® Mac Pro
•
•
•
•
•
•

Dual-core Intel® Xeon® Processor (2.66GHz)
Memory: 1GB DDR2 DIMM
NVIDIA GeForce 7300 GT
250GB SATA hard drive
16X SuperDrive™
Mac OS® X Tiger™

2499

$

CDW 1025372

Apple® Final Cut® Express HD
• Powerful DV/HDV editing
• Composite easily in-canvas
• Perform advanced color correction

$299 CDW 983895

The Mac Solutions You Need When You Need Them.
You’d like to spend as much time as possible focusing on your creative work. CDW has the
solutions that let you do just that. Our account managers can help you find the products
you need to keep the creative process going faster and more efficiently. So call today for
detailed answers to all your technology questions, and get back to focusing on what you
really enjoy: creativity.
Offer subject to CDW’s standard terms and conditions of sale, available at CDW.com. ©2006 CDW Corporation
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FROM THIS MONTH’S ISSUE

STEP OUTSIDE
The LCD displays on cameras
and camcorders can be hard
to see in bright sunlight, so
ask the salespeople if you
can take the camera outside,
especially if the camera
doesn’t have a traditional
viewfinder alongside the LCD.
From “Shop Like a Pro,” p22.
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WEASELLY WI-FI
If your AirPort signal is weak
or wayward, check these
usual suspects: cordless
phones, microwave ovens,
router placement, and other
wireless networks. Removing
such devices or changing your
router’s channel can reduce
conflicts. From Ask Us, p68.

TURN THAT CRUD OFF!
Don’t forget that you can
disable plug-ins such as
QuickTime and Flash, as well
as JavaScript and pop-up
windows, to streamline your
Web-browsing experience.
Open Safari > Preferences >
Security, or Firefox >
Preferences > Web Features.
From Ask Us, p68.

ZOOM-A-ZOOM-ZOOM
When shopping for a new
digital camera, look at the
optical zoom rating and ignore
the digital zoom. Using digital
zoom degrades the photo’s
quality—it’s better to just crop
and enlarge your picture later
in an image-editing app.
From “Shop Like a Pro,” p22.
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43 INDUSTRY AWARDS.
828 GLOWING REVIEWS.
2 VERY HAPPY EARS.

With dozens of awards and a mountain of accolades, Shure Sound Isolating TM Earphones have ironically
created quite a bit of noise in the industry. Fortunately, you won’t hear any of it. All you will hear is your
favorite music - deeper, richer, and in more detail than you’ve ever heard it before - or ever thought possible.
Visit Shure.com for more information and let the next pair of happy ears be yours.

“These are the Mercedes of headphones...” - Forbes.com
“Exquisite sound over a full range of frequencies...” - PC World
“They’re pure audio nirvana...”- CNET.com

The Innovations Design and Engineering Award is based upon descriptive materials submitted to the judges. CEA did not verify the accuracy of any submission or of any claims made and did not test the item to which the award was given.
© 2006 Shure, Inc.

Holiday ad
4C | 8”x10.5” | 43 industry awards.
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value-packed Disc with your subscription (prorated if necessary) for just $1 more per issue, call 888-771-6222—the operator will
take care of everything.

08

December 2006

CIRCULATION
CIRCULATION DIRECTOR Peter Kelly
NEWSSTAND MARKETING MANAGER Bill Shewey
BILLING AND RENEWAL MANAGER Betsy Wong
NEWSSTAND COORDINATOR Alex Guzman
FULFILLMENT MANAGER Peggy Mores
DIRECT-MAIL MANAGER Stephanie Blake
DIRECT MARKETING SPECIALIST Janet Amistoso

EiB
PGGFSF
BMJT
UFSJ

JP O
P
GB
O

On page 70 we124
show you
how to make a stopmotion animation; on
the Disc we
give you the
software you
need.

B
DN

64
F
VS

VU
'

PRODUCTION
PRODUCTION DIRECTOR Richard Lesovoy
PRODUCTION COORDINATOR Ryan Meith
%JT
E 
JUF

Be one of the first 100
MacAddict readers to
install this tinker-tool and
you’ll get a
free copy;
details are on
the Disc.

PLUS: TWO DOZEN MORE GREAT APPS!
iStopMotion
demo

C
IJ
SP
Q
UMZ
SJD

*O

REWRITE HISTORY IN HISTORY’S
GREATEST STRATEGY GAME.

Civilization IV demo

FUN & GAMES

US
B

EDITORIAL
EDITOR IN CHIEF Rik Myslewski
MANAGING EDITOR Susie Ochs
HOW-TO EDITOR Niko Coucouvanis
REVIEWS EDITOR Roman Loyola
WEB MONKEY Nick Muerdter
EPONYMEDITOR Max
CONTRIBUTING EDITORS David Biedny, Joseph O. Holmes,
Helmut Kobler, Cathy Lu, Steven Parke, Ian Sammis, Deborah
Shadovitz, Andrew Tokuda, Michelle Victoria, Buz Zoller
ART
ART DIRECTOR Mark Rosenthal
ASSOCIATE ART DIRECTOR Peter Marshutz
GROUP CREATIVE DIRECTOR Dan Fitzpatrick
PHOTOGRAPHER Mark Madeo
CONTRIBUTING PHOTOGRAPHER Samantha Berg

Edirol R-09 demo video
iFill 1.1.0 demo
LineForm 1.2.1 demo
OmniGraffle 4.1.2 trial
OmniOutliner 3.6.1
demo

F-Script 1.3.4 freeware

FS
JO
H

M QBZGPSQMBZ PSDJSDVN
SFOUB
WFOU
ODF
JPO
PG
SNB
DP
Q

DEVELOPMENT

HJO
F

SGP
QF

Edirol R-09 demo video
Fission 1.0.0 demo
iFill 1.1.0 demo

SFW
FST
FF
O

MJD

AUDIO & MUSIC

JOH

ZQ
SP
U
FD
UJP
O
JT
T
U

Guide your
civilization
from the
dawn of man to the
space age and beyond
in this astonishingly rich
strategy game.

Mac Pilot
shareware

DPQ
Z

C
QV

Civilization IV
demo

0. 6OBVUIPSJ[FE

PO
TJ
JT

There are two types of MacAddict Discs:
Ones like last month’s, which packed a full
103 apps onto its shiny silver surface, and
ones like this month’s, which features one
megahit accompanied by a couple dozen
other valuable items. This month’s 450MB
behemoth is Sid Meier’s Civilization IV, the
latest version of the world’s most popular
strategy game. Not into games? Fear
not—there’s plenty more on the Disc to
keep you busy.

JT

3
IJT$%

N
OT

the disc

E
BM
FH

JN
DMB

POU
EFE
DMV
JO
GJMF
FS

FUTURE US, INC.
4000 Shoreline Court, Suite 400, South San Francisco, CA 94080
www.futureus-inc.com
PRESIDENT Jonathan Simpson-Bint
VICE PRESIDENT/CFO Tom Valentino
VICE PRESIDENT/CIRCULATION Holly Klingel
GENERAL COUNSEL Charles Schug
PUBLISHING DIRECTOR/GAMES Simon Whitcombe
PUBLISHING DIRECTOR/MUSIC & TECH Steve Aaron
PUBLISHING DIRECTOR/BUSINESS DEVELOPMENT Dave Barrow
EDITORIAL DIRECTOR/TECHNOLOGY Jon Phillips
EDITORIAL DIRECTOR/MUSIC Brad Tolinski
DIRECTOR OF CENTRAL SERVICES Nancy Durlester
PRODUCTION DIRECTOR Richie Lesovoy

Future US, Inc. is part of Future plc.
Future produces carefully targeted specialinterest magazines, Web sites, and events
for people who share a passion. We aim to
satisfy that passion by creating titles offering
value for money, reliable information, smart
buying advice, and which are a pleasure
to read. Today we publish more than 150
magazines, 65 Web sites, and a growing
number of events in the US, UK, France, and Italy. Over 100 international
editions of our magazines are also published in 30 other countries across
the world. Future plc is a public company quoted on the London Stock
Exchange (symbol: FUTR).
FUTURE PLC
30 Monmouth St., Bath, Avon, BA1 2BW, England
www.futureplc.com
Tel +44 1225 442244
NON-EXECUTIVE CHAIRMAN Roger Parry
CHIEF EXECUTIVE Stevie Spring
GROUP FINANCE DIRECTOR John Bowman
Tel +44 1225 442244 www.futureplc.com
REPRINTS: For reprints, contact Ryan Derfler, Reprint Operations
Specialist, 717-399-1900 ext. 167
or email: futurenetworkusa@reprintbuyer.com
SUBSCRIPTION QUERIES: Please email mcdcustserv@cdsfulfillment
.com or call customer service toll-free at 888-771-6222.
MacAddict Statement of Ownership. Post Office Notice: Statement of Ownership,
Management and Circulation for Periodicals class privileges as required by 39 USC3685:
1. Publication Title: MacAddict 2. Publication No. 1088-548X 3. Filing Date: 9/29/06
4. Issue Frequency: Monthly 5. Number of issues published annually: 12 6. Annual
subscription price: $39.90 7. Complete mailing address of known office of publication:
4000 Shoreline Court, Ste. 400, South San Francisco, CA 94080 8/9. Complete address of
the headquarters of general business offices of the publisher, editor and managing editor:
Publisher: Stacey Levy - same address, Editor: Rik Myslewski - same address, Managing
Editor: Susie Ochs - same address 10. Owner: Future US, Inc, 4000 Shoreline Court, Ste. 400,
South San Francisco, CA 94080 11. Shareholder: The Future Network plc, Beauford Court, 30
Monmouth Street, Bath BA12BW U.K. 11/12. N/A 13. Publication title: MacAddict 14. Issue
date for Circulation Data below: November 2006. 15. Extent and nature of circulation given
in this order, number of average copies each issue during preceding 12 months followed by
actual number of copies published nearest filing date: a. Total number of copies 179,722
169,895 b. Paid and/or Requested Circulation (1) Mail subscriptions Outside-County 92,192
87,963. (2) Paid In-County Subscriptions 0,0. (3) Sales through dealers and carriers, street
vendors, counter sales, and Other Non-USPS Paid Distribution: 21,771 21,000. (4) Other
Classes Mailed Through USPS 0,0. c. Total Paid and/or Requested Circulation 113,963
108,963. d. Free Distribution by Mail (1) Outside County 747 797 (2) In-County 0,0. (3) Other
Classes Mailed Through the USPS 1,766 1,178 e. Free Distribution Outside the Mail 833,
0. f. Total Free Distribution 3,347 1,975. g. Total Distribution 117,310 110,938. h. Copies
not Distributed 62,412 58,957. i. Total 179,722 169,895. j. Percent Paid and/or Requested
Circulation 97%, 98%. 16. Publication of Statement of Ownership is required and is printed
in this issue of this publication December 2006. 17. I certify that the statements made by me
above are correct and complete: Peter Kelly, Circulation Director.

10

EDITORS’ PAGE
a note from the kernel

Change It Again, Steve
It’s an article of the Mac faith that when
Steve Jobs recruited John Scully to join
Apple as its CEO, he asked the then–
PepsiCo marketer, “Do you want to sell
sugar water for the rest of your life or do you
want to change the world?” It turned out,
however, that it was Steve, not John, who
succeeded in changing the world.
And now he has the opportunity to do it
again—but first, a bit of background.
At the recent gathering of gigageeks
known as the Intel Developer Forum, the company’s president and CEO,
Paul Otellini, discussed Intel’s World Ahead program, which provides
computing technology to underserved populations in developing
countries. Launched back in May, this $1 billion, five-year effort aims
“to enhance lives by accelerating access to uncompromised technology
for everyone, anywhere in the world.”
The World Ahead program is now active in 30 countries and has
trained over a half-million teachers. One centerpiece of this effort is
Intel’s Classmate PC, now in field tests but scheduled for full release
in the first quarter of 2007. This no-frills, ruggedized laptop, along
with Intel’s commitment to installing wireless Internet access in needy
classrooms, will help lessen the isolation of the impoverished.
Now here’s where Steve comes in. At a press Q&A, one journalist
asked Otellini how much the Classmate PC will cost. He answered $250,
or maybe $200 when production ramps up, but then added, “But of
course, that’s with Windows.” Do you see where I’m going with this?
Mr. Jobs, sir, I have a suggestion: Take Mac OS X, distill it down to its
basics, and provide an operating system—a free operating system—for
the Classmate PC. You have the core technology, you have the engineers,
you have the finances. You can do it. With the help of Intel, you can
change the world. Again.
In other news: We have some exciting news to share. In two months,
MacAddict will evolve into Mac|Life, a bigger, thicker, better-looking
magazine that will expand upon MacAddict’s mission to help you
get the most from your Mac. Mac|Life will be gorgeous. Mac|Life will
be entertaining. Mac|Life will be authoritative. Mac|Life will take
MacAddict’s best elements and make them even better.
Look for a preview of Mac|Life in next month’s MacAddict.

STAFF RANTS
Q. How should Steve change the world (again)?
Niko Coucouvanis

BIGGEST A-TEAM FAN EVER

How should Steve change the world (again)?

He should change his name to Mister Steve and get
a reality show. Sorry, but the studios won’t let me
elaborate on the world-changing part.

Susie Ochs

TREE-HUGGIN’ TECHNOPHILE

How should Steve change the world (again)?

How about an incentive program for recycling old
hardware to schools or nonprofits? You donate your old
Mac, and Apple gives you credit toward a new one, plus
upgrades the donated machine with more memory and
current software. Everybody wins.

Roman Loyola

SQUINTER

How should Steve change the world (again)?

How ’bout releasing the widescreen iPod and iPhonething that all the analysts, editor types, and so-called
experts continue to speculate about? Then we can stop
talking about them—that’s something in my li’l world I’d
definitely like to change.

Mark Rosenthal

MR. CROCK POT

How should Steve change the world (again)?

It’s clear—to me at least—that Steve needs to push
Apple into the arena of cookware. You know: pots, pans,
maybe even a spatula or two. How about an iWhisk?
Comes in two speeds, 1.5 or 2.5 EggaHertz. Or, in a
rebellious twist, Steve could introduce a line of slow-cookers, turning
his back on Apple’s pursuit of speed after all these years.

Peter Marshutz

WINDOWS CHOPPER

How should Steve change the world (again)?

Good idea, Rik. I agree 100 percent that Steve Jobs
should give a version of Mac OS X to third-world users
for free. It may not change the world, but it’s a start.

Max

IMPIOUS IMP

How should Steve change the world (again)?

C’mon, Rik, hasn’t he done enough for us already? Not
to sound sacrilegious, but he’s Apple’s Holy Trinity: the
creator, savior, and continuing source of inspiration.
Sure, it’d be great if he donated a couple of his billions
to some Worthy Cause™, but, if not that, I have one two-syllable
suggestion: iPhone.

Enjoy,

comingsoon:January2007
Here’s what our editors are preparing for the next issue of MacAddict.

If you’re like us, you spent a bit too much on holiday gifts ’n’ grog this year—so we’re going to show you a ho-ho-whole lot
of great free stuff for your Mac. We’re also going to give you a sneak peek at MacAddict’s next incarnation, Mac|Life,
plus we’ll show you how best to manage, troubleshoot, and extend your Wi-Fi connection. Then we’ll show you how
to do most of what .Mac does by using Firefox and free Google tools, how to soup up Safari, how to rock Ubuntu
Linux on your new Mac, and how to manage the ins and outs of iLife’s printing services. Finally, we’ll put the itsy-bitsy,
teeny-weeny iPod shuffle through its paces, and review Pentax’s K100D SLR camera, stinkbot’s TubeSock YouTube utility
software, Aspyr’s The Sims 2: Open for Business expansion pack, and a lot more.
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GET INFO
the news of the month in bite-size chunks

Left: Apple says that modo “stood
head and shoulders” above other
graphics applications.
Above: The Sims 2 won the award
for Best Mac OS X Game.

Awards Honor
Mac OS X
Innovation
Apple recognizes developers whose software
demonstrates why the Mac leads the pack.

W

hether it was the optimal
use of Open GL for real-time
shaders, taking the best
advantage of the Cocoa
application framework, or seamlessly
integrating iPhoto or Dashboard, the
variety and depth of Apple technology
was clearly showcased by the 2006
Apple Design Award winners.
According to Ron Okamoto, vice
president of Apple’s Worldwide
Developer Relations, innovation tops
the list of what the company is looking
for. “Innovation is so important to us.
We want to see what you can do on
the Mac that you can’t do elsewhere.”
Contest rules stated that entries had
to be Universal apps, run on Mac OS
10.4 and later, and “be built primarily
with AppleScript, Carbon, Cocoa,
Java, WebObjects, or any combination
of these application-development

technologies.” So whether the developer
was inventing a way to save time in a
complex publishing operation or a way
to play a game and use email at the
same time, something unique had to
be born. Other criteria included user
experience, performance optimization,
and the use of Open Source.
According to Glenda Adams, director
of development at Aspyr, one of the
new features of The Sims 2 ($49.99,
www.aspyr.com) that helped it win the
Best Mac OS X Game award was the
integration of .Mac so that “you [can]
create a new Sim character and, with one

iClip lite 2.0 is great for anyone yearning
for the days of the Scrapbook.

click, upload it to your .Mac account
and share it.”
Ben Waldie at Automated Workflows
thinks that fulfilling the needs of his
publishing clients with AppleScript and
Automator apps helped him win the Best
Mac OS X Automator Workflow award
for Build Real Estate Catalog/Ultimate
Productivity Action Pack 1.0 ($39.99, on
the Disc or www.automatedworkflows
.com). “The workflow that Apple gave
me the award for was cataloging
automation, and while it was for real
estate, that’s just one example. I
guess the actions and workflows I’ve
created are based on requests and my
knowledge of the publishing industry,”
said Waldie, an AppleScipt consultant
who used to work for TV Guide.
“Unique” and “cool” were two
other qualities Okamoto looked for.
Luxology’s modo ($895, www.luxology
.com) exhibited “optimal use of open
GL…and stood head and shoulders
[above the others],” he said. “And the
scientific app [EnzymeX 3.1], using
iPod synchronization, was Mac-unique
as well.”
When describing “cool,” Okamoto
discussed one of last year’s winners,
Comic Life ($24.95, http://plasq.com),
which creates comic strips from an
iPhoto library. What’s cool this year
is the benefit Plasq, the developer of
Comic Life, has reaped. “There are all
kinds of hidden benefits beyond just the
December 2006
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the news of the month in bite-size chunks

tangible prizes,” said Robert Grant, lead
developer. Indeed. Comic Life is now
bundled with all Intel Macs sold.
“Polish” was a quality several
developers said put them over the top.
Lineform ($79.95, on the Disc or
www.freeverse.com/lineform), a
drawing program, won the award for
Best Mac OS X Student Product, and a
blurb on Lineform’s Web site sums up
what Will Thimbleby, a Ph.D. student at
Swansea University, thinks got him his
award: “Bloated? Not a chance. Lineform
would fit on a floppy—if anyone still had
one.” Said Thimbleby, “I think Lineform
excels by providing the full power of
Quartz and Core Image integrated in an
easy-to-use interface.”
Attention to user interface was
primary for another graphics-application
winner. Brad Peebler, cofounder and
president of Luxology, which produced

modo, the 3D modeling program that
won for Best Use of Mac OS X Graphics,
credits attention to users as key to the
app’s success. “[modo] can outperform
most [other] applications in terms of
raw display, but it’s [got] that level of
polish—and who would appreciate it
more than graphic artists? One of the
things we can do is touch a key, and
certain tools will come up under your
mouse and will fade in and fade out as
you move to something else. It makes
the experience smooth.”
Some developers are already seeing
spikes in sales due to the awards. Said
John Casasanta, president of Inventive,
which created iClip lite 2.0 (free, on the
Disc or www.inventive.us), the winner for
Best Mac OS X Dashboard Widget, “Even
though iClip lite is a free Dashboard
widget, sales of the full version of iClip
have gone up.”—Anita Malnig

And the winners are...
Best Mac OS X Developer Tool
Winner: Macromates’ TextMate 1.5.2
(39 Euros, or $49.54 at press time,
www.macromates.com)
Runner-up: Philippe Mougin’s F-Script
1.3.3 (free, www.fscript.org)
Best Use of Mac OS X Graphics
Winner: Luxology’s modo 201
($895, www.luxology.com)
Runner-up: OverTheEdge’s Unity 1.5
($249 Unity Indie, $1,499 Unity Pro,
www.unity3d.com)
Best Mac OS X Dashboard Widget
Winner: Inventive’s iClip lite 2.0
(free, www.inventive.us)
Runner-up: WeatherBug Local Weather
Widget 1.1.0.9 (free,
www.weatherbug.com)
Best Mac OS X Automator
Workflow
Winner: Automated Workflows’
Build Real Estate Catalog/Ultimate
Productivity Action Pack 1.0 ($39.99,
www.automatedworkflows.com)
Runner-up: Lecture Recording Workflow
1.2 (free, www.dent.umich.edu/itunes)

Best Mac OS X User Experience
Winner: Equinux’s iSale 3.1
($39.95, www.equinux.com)
Runner-up: Boinx’s FotoMagico 1.7
($79, www.fotomagico.com)
Best Mac OS X Game
Winner: Aspyr’s The Sims 2, 1.0 Rev E
($49.99, www.aspyr.com)
Runner-up: Freeverse’s WingNuts 2:
Raina’s Revenge 1.0 ($29.95,
www.freeverse.com)
Best Mac OS X Scientific
Computing Solution
Winner: Mekentosj’s EnzymeX 3.1
(free, www.mekentosj.com)
Runner-up: SMUG’s FuzzMeasure
Pro 2.0.2 ($125,
www.supermegaultragroovy.com)
Best Mac OS X Student Product
Winner: Freeverse’s Lineform 1.1
($79, www.freeverse.com/lineform)
Runner-up: Arizona Software’s
PhotoPresenter 2.5.5 ($8,
www.arizona-software.ch)
ON THE

DISC

EnzymeX 3.1, F-Script 1.3.4, Lineform 1.1, iClip lite 2,
PhotoPresenter 2.5.6, TextMate 1.5.3, Ultimate
Productivity Action Pack 1.0
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NEW Stuff
4video visor
myvu personal
media viewer
$399
www.myvu.com
Available: Now

Perfect for

When you’re
watching Star
watching iPod
Trek: The Next
videos with the
Generation.
myvu’s pair of LCDs,
it’s like you’re in front of a 27-inch
TV. The case has a battery that
provides up to six hours of viewing
time, or increases the audio time to
20 hours.

4The Write Stuff
Books by You

$19.99
www.knowledgeadventure
.com
Available: Now

Actor John Lithgow
helps kids create their
own books with this
application, which
includes artwork,
For the budding
writing guides and
Dickens or Dr.
tips, and more. The
Seuss.
books can be printed
at home, sent via email, or ordered
and shipped to your home.

4electrical Tentacles

PowerSquid Surge3000 Calamari
$79.95
www.powersquid.net
Available: Now

This six-outlet surge protector has
a 3,240-Joule rating; a flat-profile,
360-degree-rotating swivel plug;
two glowing neon outlets; and an
audible alarm. The PowerSquid
also provides
a $500,000
limited connectedequipment warranty.
Prevent your
Mac from
getting fried.

DROOLWORTHY
Sexy Stuff We Can’t Wait to Get Our Mitts On

IMAGE COURTESY OF MINOX

Gold Standard$
Minox’s DC 1011 Carat (pricing to be determined, www
.minox.com) is a point-and-shoot camera with a 24-carat
gold-plated case and ten 2-millimeter diamonds at .03 carat
each surrounding the lens. Almost incidentally, it has a 10.1megapixel image sensor, a 2.5-inch LCD, and electronic image
stabilization.

USBling #
ATP Electronics’ Petito
($34.99 to $89.99,
www.atpinc.com)
is a USB 2.0 flash
drive that measures
1.65 by 0.8 inches. It
comes in capacities
ranging from 256MB
to 1GB; is available
in dark blue, gold,
silver, and titanium;
and has a loop for
wearing it on a chain
around your neck.
IMAGE COURTESY OF ATP ELECTRONICS

16

GET INFO

the news of the month in bite-size chunks

W

SHAREWARE PICK OF THE MONTH
Fission

www.rogueamoeba.com $32

ON THE

DISC
Fission 1.0.0

E

diting MP3 audio usually means converting it to AIFF and then recompressing it
back to MP3. Unfortunately, this process creates a generational loss in fidelity. To
the rescue comes Rogue Amoeba’s Fission, which lets you slice and dice MP3s (and
AAC, Apple Lossless, and AIFF files) and save them without taking the audio-quality
hit.—Andrew Tokuda

Let’s say there’s a
memorable quotation on an
MP3 podcast that you want
to crop and save. Launch
Fission and click the Open
Audio File icon to open
the podcast.

2 Using the Select tool,
click and drag over the
portion of audio you want
to crop. Fission lets you
scrub the audio so you
can hear it as you drag the
selection crosshairs. Click
the Crop button to delete
the unselected audio.

3 Before you save this bit of
audio, go into the Preferences
dialog (under Fission in the
menubar) and make sure the
Fade Around Cuts value is set
to 0.0; otherwise, the resulting
audio will have a fade at the
beginning and end. You’ll only
need to do this once.

4 Finally, click the Save Audio button to save the
audio clip. In addition to podcasts, Fission is great
for concert recordings, vinyl LP rips, and any audio
you might want to trim or split into smaller clips.
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• Cerventis’s

MusicJam ($229,
www.musicjammixer
.com) is a mixer that
lets you add voice
and guitar to the
music played from
your iPod. It has
electric guitar and
microphone inputs,
and RCA audio
output jacks.
• The DLO Care Kit
for iPod ($29.99,
www.dlo.com) is
a three-solution
cleaning kit for your
iPod. The kit includes
a solution for gentle
cleaning, a solution
for blemish removal,
and a solution for
removing heavy
scratches.
iBlaster Orb:
saucer of sound. • Dual Electronics’
XDVD8182 ($699,
www.dualav.com) is an in-dash mobile
video receiver for cars. It has an iPod
interface cable that lets you play your
iPod’s music, videos, and pictures
through the XDVD8182.
• Excalibur Electronics’ iBlaster Orb
($79.95, www.excaliburelectronics.net)
is a speaker stand that charges your iPod
while it’s docked; it’s available in black,
blue, green, orange, red, and white.
• Griffin Technology’s iKaraoke (price
TBD, www.griffintechnology.com) is a
microphone that plugs into your iPod
so you can sing along with your songs.
It can fade the existing vocals of your
music into the background, and it has an
FM radio transmitter so you can play the
audio over your stereo.
• JVC’s RA-P10 ($129.95, www.jvc.com)
is a portable radio alarm clock with an
iPod dock. It measures a foot long and
less than three inches tall, and also has
a room thermometer.
• Sonnet’s Volta ($69.95, www
.sonnettech.com) is a battery adapter
for video-capable iPods that, combined
with a charged iPod, increases the total
video playtime up to 16 hours, or up to
80 hours of music listening.
• V-Moda’s Bass Fréq ($50, http://shop
.v-moda.com) and Remix Metal Class
($50) earbuds are available in several
different colors.—Michelle Victoria
iPOD ACCESSORIES

hile you’re waiting for Office 12, the
code name for the Universal version
of Office for Mac, Sheridan Jones, the group
marketing manager for the Mac Business
Unit (Mac BU), suggests that you download
Messenger for free and get a taste of what’s
to come. “We always develop based on
feedback that we hear from users,” she said.
Jones stressed that any software
developed in the Mac BU is “never just
Why use Messenger instead of iChat?
ported over.” One feature of Messenger that Because some people work in a Windows
Jones touted as newsworthy is its ability to
world.
spell-check messages, doing so by tapping
into the Apple dictionary.
What about Office 12? Jones said that it will take from six to eight months after
the release of 2007 Microsoft Office System for Windows for Mac BU to release the
Mac version “to ensure compatibility.” Jones asserted that “Mac users will be happy
to know that the next version of Office will continue to be very Mac-like.” Jones did
confirm that Office 12 will move to Open-XML file format, and that when WinOffice
launches, Microsoft will provide open-XML converters to Mac users.—Anita Malnig

What’sNew

Intel-icized Messenger now a free download; new Office for Mac coming
soon…or soon-ish.

>>>>>>>>

MICROSOFT GOES (A BIT) UNIVERSAL

I’m an APC. I protect Macs.

APC Smart-UPS® 1000 provides
power protection and battery
back up during power outages.

Learn why 30 million people protect their music, photos and financial files with APC.
“Overall the reliability of
electrical systems in the US
almost certainly will decline
over the next 10 years.”
- Venture Development
Think of all that you rely on your computer for: personal and business files,
financial information, broadband access,
videos, photos, music, and more.
Increasingly, computers are the hub for
managing our lives. And more people
rely on APC to protect their hardware
and data than any other Uninterruptible
Power Supply (UPS) brand.

Why is APC the world’s best selling
power protection? For 20 years, we
have pioneered power protection
technology. Our Legendary Reliability®
enables you to save your data, protect
your hardware, and prevent downtime.
It also guards against a power grid that
is growing less reliable every day.
According to the Department of Energy,
electricity consumption will increase by

40% over the next 10 years. Yet today,
investment in utilities is at an all-time
low. It’s a “perfect storm” for computer
users, one that makes APC protection
even more essential.
APC has a complete line of power
protection solutions to suit a range
of applications. Already an APC user?
Get the latest Replacement Battery
Cartridge for your unit or upgrade to
a newer model.

Find out why 30 million people don’t
need to worry about losing their
music, photos, and financial files.

APC Solutions for Every Level of Protection
Back-UPS® ES 550R

Home Starting at $59.99

Best value battery backup and surge
protection for home computers.
8 outlets, DSL protection, 44 minutes of runtime

Home Office Starting at $99.99

Back-UPS® ES 750

Complete protection for home and small
business computers.
10 outlets, DSL and Coax protection, 70 minutes of runtime

Small Business Starting at 459.00
$

High-performance network power protection
with best-in-class manageability for servers.

Smart-UPS® 1000

Buy now - Special Offers!
1. Loyal APC customers save on
Replacement Battery Cartridges.
2. Get details on special promotional
offers on APC Back-UPS and
Smart-UPS solutions.
3. Download your FREE informational
brochure “The Seven Types of Power
Problems”.

Find APC power protection products at:

Visit www.apc.com/promo Key Code p930x
Call 888-289-APCC x6958
or Fax 401-788-2797

©2006 American Power Conversion Corporation. All Trademarks are the property of their owners. • E-mail: esupport@apcc.com
132 Fairgrounds Road, West Kingston, RI 02892 USA • BK4B6EF-US
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Bug of the Month
>>>>>>>>>>>>>>>>>>>>>>>>>>>>

It’s not
IMAX, but
it’s cuter.

iPOD CASE
OF THE MONTH

FIX EMBEDDED MEDIA IN
SAFARI

D

on’t you just hate it when you
can’t get a QuickTime or Flash
file on a Web site to work? You have
the proper plug-ins installed, so
what’s the deal?
QUICKTIME To fix a QuickTimerelated problem with Safari, quit
Safari and look in the /Library/
Internet Plug-Ins folder (this is the
Library folder at the root level of
your hard drive, not the one inside
your Users/user name folder). Try
removing the VLC Plugin.plugin
(if you have it) and QuickTime
Plugin.plugin files from this folder,
and then relaunch Safari. If the
problem isn’t fixed, a different plugin may be to blame. Keep removing
files from this folder (start with any
third-party plug-ins that are present)
until the problem disappears.
Replace the plug-ins that don’t
cause any problems.
FLASH The most common Flash
problem is that the audio doesn’t
work, usually caused by an
erroneous Audio Output setting.
Here’s the fix.
1. Launch Audio MIDI Setup
(/Applications/Utilities).
2. Click the Audio Devices tab at the
top of the window.
3. In the Properties For pull-down
menu, select Built-in Audio.
4. Change the Audio Output > Format
setting to 44100.0Hz.
5. Quit Audio MIDI Setup.
6. Quit and relaunch Safari.
ROSETTA If you have an Intel-based
Mac, running Safari in Rosetta can
also resolve some plug-in issues.
First quit the app if it’s open, and
then, in your Applications folder,
select Safari and press CommandI. In the General area of the Safari
Info dialog that appears (click the
disclosure triangle if this area is not
already expanded), select Open
Using Rosetta, and then close the
Safari Info dialog. Relaunch Safari.
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FLIP MOVIES
INTO BOOKS

It’s a case
and a
battery.

F

lipClips (www.flipclips.com) is a
service that can take those short
videos you shoot with your digital
camera and convert them into flip
books. Flip through the pages quickly
and you can see the motion of
your movie.
You can use movies formatted in
QuickTime, AVI, DV, MPEG-4, and a few
other formats. You upload the movie
(the maximum file size is 25MB) and
choose one of three different formats: a
3.5-by-2-inch Flip Book ($8.99), a 4.25by-3.25-inch Greeting Card ($10.99),
or a 4.5-by-3-inch Story Book ($18.99).
FlipClips also offers bulk pricing if you
want multiple copies.—Roman Loyola

iLuv’s i603 and i604 (both $64.95,
www.i-luv.com) are silicone cases
with supplemental rechargeable
batteries. The i603 is for the 30GB
5G iPod and provides up to 42
additional hours of power. The i604
fits the 60GB 5G iPod and gives you
55 more hours.—Michelle Victoria
SUBMIT YOUR CASE Whether your iPod case is a
custom-made one-off or mass produced, you can submit
it for Case of the Month consideration—just send it to
iPod Case of the Month, MacAddict, 4000 Shoreline Ct.,
Ste. 400, South San Francisco, CA 94080. Please note
that we cannot return cases.

APERTURE, PHOTOSHOP
LIGHTROOM GET UPDATES

A

pple recently released Aperture
1.5 ($299, www.apple.com), a free
upgrade for current Aperture owners.
And at the same time, Adobe announced
a new free beta 4 release of Photoshop
Lightroom (http://labs.adobe.com/
technologies/lightroom).
In version 1.5, Aperture now has
flexible library management, which lets
you store your photos wherever you
want—including on external drives—and
not just in the
unified database
that pervious
versions of
Aperture used.
Color controls
have been
expanded. Other
new features

include onscreen controls for
Aperture’s Loupe, Edge Sharpen
controls, and more.
Photoshop Lightroom (née
Lightroom) features several interface
enhancements, including a redesigned
toolbar and filmstrip additions. Many of
the new features are a result of Adobe’s
acquisition of Pixmantec’s RawShooter
software, which specialized in handling
photos in RAW format. The Photoshop
Lightroom beta
4 is scheduled to
expire February
28, 2007.
—Roman Loyola
Aperture 1.5
is a Universal
application.

Left

Left

Right

Right

Shop
Like a Pro
Can’t-Fail Strategies for
Successful Shopping

by Roman Loyola, Rik Myslewski, Rick Oldano, and Andrew Tokuda
Photography by Mark Madeo

M

acs are easy. Shopping for one, however, can be hard. Whether you’re in the
market for a digital camera or camcorder, a printer, or even a humble hard
drive, you have to wade through a welter of specs—and sometimes it’s hard to
figure out which information you should care about and which you should ignore.
Luckily, we’re here to help. We’ll arm you with all the info you need to make an
informed purchase, including the specs you need to know about, what to do when
shopping, and which questions to ask those carnivorous salesfolk.
We’ve also rounded up a slew of our favorite products, and divided them up into
three categories:
QUALITY These items are among the best available; you can’t go wrong.
VALUE Want to save a few bucks and still get a great product? Here y’go.
STYLE Sometimes elegant design trumps quality and value.
So before you take the plunge and drop a few hundred bucks or more on your next
techno-toy, read on. Buyer’s remorse will soon be a thing of the past.
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Point-and-Shoot Cameras

You could spend a thousand dollars or more on a digital SLR camera, but do you really need that much photo power and
flexibility? You can take great pictures and make 8-by-10-inch prints from the image files created by a simple, easy-to-use
point-and-shoot camera. Even better, you’ll only need to shell out a fraction of the cash.—Rick Oldano

Important Specs

Ask the Salesperson

VIEWFINDER Does the camera have an optical viewfinder, or do

HOW MANY SHOTS WILL THE MEMORY CARD HOLD? The

you have to frame the picture on the LCD display before you shoot?
While some of the newer point-and-shoot cameras have only an
LCD display, using it exclusively can drain the batteries faster, and
the screen can be difficult to see in strong sunlight.
ZOOM Check the camera’s optical zoom rating—the larger that
number, the greater you can magnify the image. Ignore digital
zoom ratings; using a digital zoom degrades image quality, so
enlarge your picture, if need be, in an image-editing app.
ISO RATING Look for a camera with an adjustable ISO setting that
ranges up to 800 or more. Increasing the camera’s light sensitivity
will enable you to shoot in dark situations, though image quality may
degrade due to increased image noise.
CONNECTION You’ll want to get to your pictures quickly, either
on your Mac via a USB 2.0 connection or directly to any PictBridgecompatible printer—if, of course, the camera is PictBridgecompatible. Don’t forget, however, that a card reader attached to
your Mac will likely be the fastest form of image output.

number of pictures you can store on the included flash memory
card will often be quite small. Ask how much additional cards cost.

When You’re Shopping
HOLD THE CAMERA Be sure that the camera you’re considering
fits comfortably in your hands and that all its controls are easy to
reach. A camera may win a design competition, but if it’s clumsy,
bulky, or too tiny, or if it’s difficult to reach the shutter release
button, you stand a good chance of missing the shot.
CHECK WAKE-UP TIME Just about every digital camera will go
to sleep on you if you don’t take a picture soon after the last one.
Find out how quickly a camera will be ready for the next picture
you want to take after it comes out of sleep.
CHECK SHUTTER LAG You see the picture of a lifetime as
your pet poodle crosses the finish line at a Flyball competition.
Will the camera you’re considering take that memorable picture
immediately? That is, how long will it take to snap the shot after
you press the shutter release?

Our Recommendations
QUALITY
PowerShot S3 IS
$399.99 Canon www.canon.com
800-652-2666
One capability to get thrilled over
in this feature-filled bargain is
image stabilization, which allows
you to pay less attention to
camera jiggle and more attention
to getting the perfect shot.

VALUE
Exilim EX-Z60
$249.99 Casio www.casio.com
800-836-8580
This little beauty fits in your shirt
pocket without sacrificing too
many features or image quality.
On a price-per-feature basis, it’s
a great bargain—just be sure your
shirt pocket has a button on it.

STYLE
D-LUX 3
$599 Leica www.leica-camera
.com 800-222-0118
Throw a switch and this beauty
records in one of three aspect
ratios. Also, its 2.8-inch TFT LCD
monitor will ensure that you can
see what your image will look
like without needing to squint.

Digital SLR Cameras

Flexibility is the key word when considering a digital SLR (single lens reflex, meaning you view the image to be shot
directly through the lens, not through a separate viewfinder or on an LCD). You have numerous options when it comes to
interchangeable lenses, which range from ultra–wide angle to super-zoom telephoto. Many SLRs have large, high-quality
image-capturing chips plus sophisticated image-processing electronics—these advantages generate superior images than
those shot by point-and-shoot cameras.—RO

Important Specs

better your control over light and focus.

FOCUS AND METERING POINTS Most digital SLRs have several

IMAGE-CAPTURING CHIP SIZE Digital SLRs generally contain

focus and light-metering points, selectable on a shot-by-shot
basis. You can focus or meter on objects in the foreground or the
background and still keep everything in the frame. In general, the
more focus and metering points and the easier they are to select, the

larger CCD or CMOS imagers than point-and-shoot cameras, with
larger per-pixel areas. These larger pixels generate images that suffer
less from excessive noise. The larger pixels are also more sensitive
to light, thus providing the camera with an expanded ISO range.
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burst mode Digital SLRs have an image-capture burst mode
that mimics a film camera’s motor drive. You should be able to
capture anywhere from three to five frames per second at high
resolution and have up to dozens of images stored in buffer
memory before the camera has to write images to the storage card.
custom lenses Digital SLR manufacturers have begun to
introduce new lenses that are specifically designed for digital
cameras, which have an imaging area smaller than the size of
a frame of 35mm film. These provide you with additional—and
generally less expensive—options for lens purchases.

When You’re Shopping
don’t assume the camera comes with a lens

Remember, one of the greatest advantages that a digital SLR has
over a point-and-shoot is its use of interchangeable lenses. As
with 35mm film SLR camera bodies, you will need to ask whether
the camera you are considering is sold as a “body only” or as a kit
with one or more lenses.
check the file formats Check to see in which file formats the
camera will capture images. All cameras will generate JPEG-format
files, but will the camera you’re interested in generate a TIFF or a
RAW file? How about both TIFF and RAW? Will it create a JPEG and
a RAW at the same time? That last combination ensures that you’ll
get the highest-quality image (RAW) but still have the convenience
of a quick preview (JPEG).
invest in a decent flash While most cameras have a built-in
flash, a digital SLR will likely have an external hot shoe on top of
the viewfinder to let you mount an optional flash unit that’s vastly
superior to the camera’s built-in flash. Find out what flash units are
available, their prices, and their effective ranges, and then invest
in one that meets your needs.
ask about accessories Inquire as to what other optional
equipment or accessories will work with the camera you select.
These could range from several macrophotography options to
remote-control actuators.

Ask the Salesperson
what lenses are available? Ask the salesperson to show

you how many lenses are available for your camera body. The
salesperson should at least be able to show you a catalog or
brochure that shows the full ranges of lenses and whether they all
fit this camera body. If you already own some pricey lenses, make
sure they work with the SLR you’re considering (duh...).

how many pixels are actually used? Ask the salesperson

what the effective pixel count is. There are generally several
thousand pixels on the imager that are not used to capture an
image. For example, if a salesperson says the camera has 6 million
pixels, it may only have 5.5 million pixels that are actually used to
capture your image. Generally speaking, the more active pixels,
the merrier.
how do I get this sucker fixed? Since many digital
cameras are now being sold in stores other than camera shops,
ask the salesperson that if your camera requires repair under
warranty, can you return it to that store or are you required to ship
it off to a repair facility yourself? Then ask who pays for shipping
while the camera is under warranty.

Our Recommendations
Quality
EOS Digital Rebel XTi
$799.99 body only; $899.99
with 18mm-55mm, ƒ3.5-5.6 lens
Canon www.canon.com
800-652-2666
This camera has features that
were, until recently, only available
on more expensive models.

Value
EVOLT E-500
$699.99 body only; $799.99
with 14mm-45mm, ƒ3.5-5.6 lens
Olympus www.olympus.com
888-553-4448
This is a great camera at a great
price, with a selection of highquality lenses that produce equally
high-quality images.

Style
D80
$999.95 body only; $1,199.95
with 18mm-55mm, ƒ3.5-5.6 lens
Nikon www.nikonusa.com
800-645-6687
This camera’s image-processing
engine is similar to the ones in
Nikon’s pro-level—and much
more expensive—D200 and D2X.

Photo-Quality Printers

If all you ever plan to print are snapshots, skip on ahead to our “Snapshot Printers” section (p26). But to display your
photographic skills in all their radiant glory, nothing beats a good photo-quality printer. If you want to frame your work, we
recommend shopping for a printer that can output at least tabloid-sized photos; trust us, the extra cash will be worth it when
you contentedly admire your artistry from across the room.—Roman Loyola

Important Specs
dye or Pigment Ink isn’t just ink; there are two basic kinds.

Dye-based inks are more affordable than pigment-based ink, but
dye-based inks fade faster. For photo archives or that gorgeous
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shot you want to hang on the wall, go with pigment inks. Dyebased inks are fine for more-casual use, however. For best results,
use paper types recommended by the printer’s manufacturer—the
ink and paper work together to give you the best results.

Digital Video Cameras

When it comes to digital video, there are two types of users: Vacation videographers want a camera that’s portable and
easy to use, while digital filmmakers use their cameras to make the next blockbuster movie. Consumer-level cameras are
available for members of both camps, but it’s important to know which features are important for whom.—Andrew Tokuda

Important Specs
MiniDV or HDV with FireWire Say no to DVD and hard-disk-

based camcorders—they don’t use a video format that’s friendly
with iMovie or Final Cut. Choose a camera that uses MiniDV or
HDV. Also, say no to USB; Apple apps require FireWire.
3CCD A three-CCD camcorder uses three separate charge-coupled
devices, or CCDs, to capture the red, green, and blue colors of
an image, which provides better-quality images than that of a
single-CCD camcorder. If you have a discerning eye for good picture
quality, pay the extra bucks for a 3CCD camera. You won’t regret it.
Microphone Jack Budding pros soon discover that the sound
is just as important as the image. A camera with a microphone jack
will allow you to connect an external mike for better sound control
and less camera noise infecting your shot.
Built-In Light Built-in lights are good for shooters who only use
their cameras for fun, but are of little use when it comes to digital
filmmaking—unless your goal is that Blair Witch Project look.
Manual CONTROLS If you have a creative eye, you’ll want
control of focus, exposure, and white balance. A camera with
these manual-control options provides creative control, while its
automatic setting will keep things easy for vacation videos.

When You’re Shopping
caress the camcorder Hold each camera, feel its weight,
and see how easy it is for your fingers to reach all the controls.
Some cameras let you use larger batteries, which provide more
recording time but add weight.
Look at the LCD Anticipate how the camcorder’s LCD monitor
will look in broad daylight. Some stores might let you take the
cameras outside—it’s worth asking, at least.
try both touchscreen and button controls Some
cameras have touch-screen controls on the LCD, while others are
controlled by buttons and dials. LCD-based controls may offer
more features, but hardware controls are quicker to access.

Ask the Salesperson
Are you a Mac user? It’s best to rely on your own at-home

the salesperson will probably steer you toward a camcorder that’s
going to give him a better commission, or claim that a camera is
Mac friendly, not knowing any better.
Can I try out some accessories? Ask to try out
accessories that are tailored for the specific camera you’re
investigating; you can see firsthand what a wide-angle adapter
does or how an external microphone sounds.

Our Recommendations
Quality
Panasonic AG-DVC20
$1,595 Panasonic www
.panasonic.com 800-405-0652
This camera has a bigger lens
than most consumer camcorders,
three CCDs that give it great
color, and a shoulder mount to
provide stability and comfort.

Value
Panasonic PV-GS300
$599.95 Panasonic www
.panasonic.com 800-405-0652
Panasonic lets you dip your toes
into pro-quality waters by offering
this relatively low-cost three-CCD
camera. It also has optical image
stabilization, a technology that’s
superior to digital interpolation.

Style
Sony HDR-HC3
$1,399.99 Sony www
.sonystyle.com 877-865-7669
This camera records in both
1080i HDV and Standard
Definition DV using standard
MiniDV tape. Along with its
versatility, it’s got that inimitable
Sony sleekness.

research, especially as a Mac user, because when you go shopping

Media handling Most photo-quality printers can handle
sizes ranging from 4 by 6 inches to 8 by 10 inches. Some can
handle roll-fed media, handy for printing mass quantities or
landscapes. Epson inkjets are the only printers in this category
that can print directly on printable CDs and DVDs. Think outside
the paper box, as well: Want to print on canvas? See if your
printer has a pass-through slot.
Speed Printers are rated at pages per minute (ppm)—the higher
the ppm, the faster the printer. Look at this number carefully,
however, because vendors often state speed at draft mode
to convey better performance. Also, the rated speed usually

involves just the physical print time; it doesn’t include any image
processing your Mac needs to perform.
Connectivity Your Mac connects to most printers via USB,
though some printers offer a FireWire option. Many photo
printers also have a PictBridge connector; if your camera
supports PictBridge, you can connect it directly to the printer.
Also, some printers have card slots, so you can take your
camera’s memory card, insert it into the printer, and print a
picture. Cheaper printers won’t have these features—and serious
hobbyists and pros would never print a photo without some
preliminary Photoshop work.
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Print Quality We’re talkin’ photo printers, so they already
have the resolution needed to print photos. Don’t get bogged
down by resolution banter. However, high-priced printers do
tend to create better-looking pictures—they either have higher
resolutions, use more than the basic cyan-yellow-magenta-black
inkset, or both. Epson’s killer Stylus Photo R2400, for example,
uses nine different ink cartridges.

Our Recommendations
Quality
Stylus Photo R2400
$849.99 Epson www.epson.com
800-463-7766
This surprisingly compact printer
produces gorgeous color photos
and jaw-dropping black-andwhite photos with a maximum
print size of 13 by 44 inches.

When You’re Shopping
Print your picture Don’t settle for store-supplied print
samples—they’re tricked out to the max. Print what’s familiar;
bring your own picture with you on a CD, flash drive, or on your
camera, and print it at the store. Call first to find out if they’ll let
you; if not, go someplace else.
Get experience Play with the printer’s controls. Investigate
the available options in the driver software. Listen to the
printer while it’s at work. Watch the paper feed to make sure
it’s running smoothly. If something feels—or sounds—not right,
look elsewhere.

Value
Stylus Photo R260
$129.99 Epson www.epson.com
800-463-7766
A nice combination of speed, image
quality, features, and price, this
little guy has built-in automatic
color correction, tools for fixing
red eye, PictBridge, support for
CD/DVD printing, and more.

Ask the Salesperson

Style

Where are the print heads? They’re either built into the

Pixma iP1700
$49.99 Canon www.canon.com
800-652-2666
While it’s missing several
features (hey, whaddaya expect
for 50 bucks?), this looker has
an 8.5-by-11-inch print area and
uses a combined color cartridge
and a black ink cartridge.

printer, built into the ink cartridge, or they’re a separate unit from
the ink. You may need to replace the print head if you print high
volumes, so it helps to know what you need to replace: the ink
cartridge, the print head itself, or the entire printer.
Do I need a cable? Some printers don’t include a USB cable,
so prepare to add an extra $10 to the price. You’ll most likely need
an A-plug-to-B-plug USB cable.

Snapshot Printers

Our Recommendations

Unless you’re planning to frame your prints, a snapshot
printer may be all you need. Most of these li’l gems can
crank out standard-size 4-by-6-inch or 5-by-7-inch prints
quickly, easily, and affordably—and they’ll save you a trip to
your local Walgreens.—RL

Quality
Photosmart A716
$249.99 HP www.hp.com
800-752-0900
This little box prints gorgeous
4-by-6s and 5-by-7s, lets you do
minor image edits, has 4GB of
storage, and supports Bluetooth
printing from phones and PDAs.

Important Specs
Ink or dye sub? Most snapshot printers use inkjet technology,

but some use dye sublimation. Dye subs produce a better range
of colors and continuous tones, but the per-image media and dyeribbon costs of using a dye sub is usually higher than that of an
inkjet printer.
Portability These printers are made for toting, so look for
carrying handles or cases, portable power supplies and batteries,
and light weight.
Connectivity If you’re printing on the go, you’ll be connecting
your camera directly to your snapshot printer, so look for
PictBridge connectivity with your digital camera. Also, look for
card slots, so you can take your camera’s memory card, insert it
into the printer, and print a picture.
LCD Many snapshot printers have full-color LCDs that let you
preview the image you’re about to print, and built-in software that
allows you to make minor image edits. Lower-priced snapshot
printers won’t have an LCD.
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Value
PictureMate Pal - PM 200
$149.99 Epson www.epson.com
800-463-7766
This printer with an LCD display
can print 4-by-6-inch photos
from your memory card or via a
PictBridge connection. For nononsense picture printing, the
PictureMate Pal is a great deal.

Style
HiTi Photo Printer S400
$249 Hi-Touch
www.hitouchimaging.com
909-974-0099
This gorgeous dye-sub printer
keeps dust out of its insides
so that you don’t get annoying
specks in your prints.

When You’re Shopping

Ask the Salesperson

Bring your camera Make sure it’s full of pics—remove the

What’s the price per page? Extrapolate the cost of

risqué ones first, unless Aunt Eloise is an exhibitionist. Connect
your camera to the printer and print a few samples. You’ll not only
see the printer’s image quality, but also get hands-on experience
on how easy—or difficult—the printer is to use.
Carry it If you plan to travel with the printer, close it up and
carry it. Also, check to see if a protective case is available. The
printer shouldn’t be unwieldy, too heavy, or have important parts
unprotected. Don’t forget to consider the power adapter, paper,
ink, and other accessories you’ll want to pack.

consumables per printed page and compare it to the cost of
using a professional photo processor. The typical cost per page
for a snapshot printer is about $.25 per print. You can get prices
as low as $.16 per print at a service bureau, but that doesn’t
consider the value of time and convenience—which only you
can put a price on.
Are print packs available? Many snapshot-printer
manufacturers sell packs, which include paper and ink, that
make it easier to refill your printer.

SOHO Printers

For your small office (SO) or home office (HO), you want a printer that can output a large number of prints per month (a
spec called its duty cycle). You also want crisp text—laser printers excel at this—and don’t care as much about stunning
photographic output. After all, a fine photo-quality printer is overkill for a simple Excel chart.—RL

Important Specs
Inkjet or laser? Laser printers continue to drop in price;
monochrome laser printers are now exceptional bargains. Inkjet
printers are affordable but unsuitable for high-volume printing
and generally not as good at plain-text printing as lasers are.
Speed Stated in pages per minute (ppm). Make sure you’re
comparing numbers tracked at similar print qualities—the
optimal speeds stated by many inkjet vendors are often based
on printing in low-resolution draft mode. Laser printers are faster
than inkjet printers but are usually more expensive.
Resolutions Usually stated in dots per inch (dpi). The higher
the resolution, the better the image quality. Basic laser printers
have a standard resolution of 600 by 600 dpi, which works fine
for text and business graphics.
Connectivity If it’s just you, your Mac, and your printer,
you’re fine with USB. But if you have multiple Macs, look for
Ethernet or wireless connectivity.
Media handling Save yourself from irritating “printer out of
paper” messages by making sure the printer has a large enough
paper capacity to suit your needs.

When You’re Shopping
Print it Copy a text file, a slide presentation, and a

spreadsheet to a CD or flash drive, and print them at the store.
Don’t rely on in-store print samples—they be cheatin’. Use
documents you’re familiar with—if you created a doc, you know
how it should look.
Touch and listen Try opening the printer and replacing the
toner or ink cartridges to see how difficult it is to do so. Also,
listen to the printer as it prints—you don’t want to wake your
housemates during your late-night print sessions.

Ask the Salesperson
Is there a Mac driver? Some vendors don’t include their

Mac-compatible driver software in the box; you’ll have to
download it from the Web. Other vendors don’t even have Mac
drivers. Stay away from them.

Where’s the pass-through slot? A pass-through slot on
a printer allows envelopes, labels, and other media to go straight
through the printer, instead of curling through the standard path
used for plain paper. No pass-through path? That printer will
have trouble printing envelopes and labels, let alone that poster
you want to print on card stock.

Our Recommendations
Quality
magicolor 2530 DL
$399 Konica Minolta
http://printer.konicaminolta.net
800-523-2696
This affordable color laser has
USB, Ethernet, and PictBridge,
and is rated at 5 ppm for color
and 20 ppm for monochrome.

Value
HL-2070N
$149.99 Brother www.brotherusa.com 800-284-4329
This li’l monochrome laser printer
produces crisp text and excellent
grayscale graphics. Rated at 20
ppm, it has a 250-sheet paper
tray, Ethernet, USB, and 16MB of
memory—all for 150 bucks. Damn.

Style
Pixma iP90
$249.99 Canon www.canon.com
800-652-2666
The portable inkjet iP90 is rated
at 16 ppm for monochrome
prints and 12 ppm for color—just
make sure to bring some extra
ink along with you, since its
cartridges are on the small side.
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Multifunction Printers

Desk space is a valuable commodity; wouldn’t it be nice to have a single device act as your scanner, copier, printer, and fax
machine? That’s the job of a multifunction printer, aka MFP or all-in-one. Once derided as jacks-of-all-trades but masters of
none, these versatile space-savers have improved greatly in recent years. If you’re strapped for space, give them a look.—RL

Important Specs
multifunction Speed Stated in pages per minute (ppm).

Make sure you’re comparing numbers tracked at similar print
qualities—many MFP vendors state their printers’ speeds
based on printing in low-resolution draft mode. Also, remember
that although laser printers are faster than inkjet printers,
they’re more expensive. Finally, note that although one MFP
may be fast at printing, it can be dog-slow at faxing, scanning,
and copying.
Resolutions Usually stated in dots per inch (dpi). The higher
the resolution, the better the image quality. Most low-cost laser
printers have a standard resolution of 600 by 600 dpi, which
works fine for text and business graphics. Look for scanner
resolutions of at least 1,200 by 2,400 dpi. When looking at

scanner specs, ignore interpolated resolution numbers—they’re
total digital BS.
Memory MFPs use memory to store pages, whether you’re
faxing, copying, or printing them. The more memory in the MFP,
the faster it will perform.
Media handling If you have multipage documents, look for
automatic feeders for the scanner and copier. If your office is small
but busy, you might need additional paper bins. You also need to
consider duplex handling (automatic printing on both sides of the
same sheet of paper).

When You’re Shopping
print samples Take a typical file that you use, put it on a CD

or flash drive, and print it at the store. While you’re at it, make a

External Hard Drives

Sooner or later, you’re going to run out of space on your Mac’s internal drive. Sooner or later, you’re going to begin a
conscientious daily backup regimen. Sooner or later, that is, you’re going to find yourself shopping for an external hard drive.
Luckily, the hard-drive industry is a mature one, with nearly uniformly fast drive mechanisms, constantly improving reliability,
and perpetually sinking costs. There are, however, a few things you need to keep in mind while shopping.—Rik Myslewski

Important Specs
capacity Buy the largest-capacity drive you can afford, but it’s

best to avoid the absolute largest-capacity drives available. Topcapacity drives use the latest technology—drives of lesser capacity
have had more time for their engineers to tweak their reliability.
seek time How fast a drive’s read/write head can get to the
data you need is called its seek time. While this was once an
important factor in drive performance, most drives now have such
speedy access times that you won’t notice the difference in minor
variations of this spec.
cache size Modern drives include memory caches that allow
them to store data that they think you may search for next, and to
give data from your Mac a place to wait while the drive writes it
to disk. While a large cache can help the performance of a drive
as it reads or writes small bits of information—database access,
for example—it’s of lesser importance if your work streams large
amounts of data from the same file, such as in video, audio, or
large-image work.
rotational speed This one’s easy: The faster a drive’s platters
spin, the faster the read/write head can get to the information you
need, and the faster it can provide that data to your Mac.
connection type Most of today’s external drives connect to
your Mac in one of four ways. In ascending order of performance,
these are USB 2.0, FireWire 400, FireWire 800, and eSATA. If your
Mac has a FireWire 800 port, buy a FireWire 800 drive, but don’t
expect it to perform twice as fast as a FireWire 400 drive; think 30
or 40 percent faster, at best. Drives with eSATA connections are
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blazingly fast, but you’ll need to equip your Mac with an eSATA
card to connect one, because no Macs have built-in eSATA ports.

When You’re Shopping
check for a fan Most desktop drives put the power supply

outside the case so that they don’t require a noisy cooling fan.
Some higher-capacity drives—such as those that contain more
than one drive mechanism—need an internal fan to cool things
down. Make sure that the fan’s noise won’t bother you.
check for durability Your external desktop drive will simply
sit safely on your desk, but make sure the portable drive you
select is properly ruggedized, preferably with shock-absorbing
materials either on its case or inside, protecting the drive
mechanism. Portable or desktop, metal cases can also help to
keep a drive mechanism cool.

Ask the Salesperson
What’s your restocking fee? As with any purchase other

than a Coke from your office vending machine, always ask about a
vendor’s return policies. Some drive vendors charge a hefty fee if
you need to return a drive. While this is a perfectly reasonable way
for them to keep their costs—and, therefore, their prices—low, it
can be a stone drag if the drive you receive is a lemon.
Is the bundled software Mac-compatible? Many drive
manufacturers include a software bundle to sweeten the deal.
Unfortunately, however, some of the software may not be Maccompatible—security software, for example, is often PC-only.

Our Recommendations
Quality

copy of your print, scan it, and print the scan. Determine image
quality using your own documents, not the ones provided at
the store.
Poke and prod Try as many of the MFP’s features as you
can. It would really be a bummer to take home a MFP with a slow
copying feature that you didn’t expect, or one for which it’s a
bear to replace the consumables.

Ask the Salesperson
What’s the return policy? This may sound obvious,

but considering that your MFP does many things, your chances
are higher that something will break. Most resellers will charge
a restocking fee, even if you return your MFP under a generous
warranty.
Does it fax? In this emailed world, fax is quickly becoming
an afterthought, and it’s often excluded in order to cut costs. If
you need fax, be sure the MFP you’re considering has it—don’t
assume fax capabilities.

Our Recommendations
DESKTOP DRIVES

AcuLaser CX11NF
$799.99 Epson www.epson.com
800-463-7766
This color laser MFP is fast,
feature-rich, and produces
nice-looking output. It has a 180sheet paper tray and a 50-sheet
auto-feeder for copies and scans.

Value
MFC-240C
$99.99 Brother www.brotherusa.com 800-284-4329
This way-inexpensive four-color
inkjet MFP has memory-card slots
for printing photos from your
digital camera, a 100-sheet paper
tray, and a 10-sheet auto-feeder.

Style
Pixma MP960
$399.99 Canon www.canon.com
800-652-2666
This sleek six-color inkjet has
PictBridge and 35mm-slidescanning support. Although the
MP960 is designed for photo
printing, it also has the speed
you need for your business docs.

PORTABLE DRIVES

Quality

Quality

Big Disk Extreme with Triple
Interface
$619.99 (1TB) LaCie www.lacie
.com 503-844-4500
This solidly built two-mechanism
drive has a rugged case, FireWire
400, FireWire 800, and USB 2.0
ports. Although it has an internal
fan, it’s a quiet, intelligent one.

ToughTech mini
$343.95 (100GB) WiebeTech www
.wiebetech.com 866-744-8722
The ToughTech mini has FireWire
800, FireWire 400, and USB 2.0
ports and comes with your choice
of a variety of fast SATA drives; we
recommend getting yours with a
100GB, 7,200 rpm mechanism.

Value

Value

Neptune FireWire Drive
Enclosure
$44.95 Other World Computing
www.macsales.com 800-275-4576
You read that price right—but
realize that you’re paying only for
the FireWire 400–equipped case;
you’ll need to supply and install
your own drive (an easy task).

Mercury On-The-Go
$164.99 (120GB) Other World
Computing www.macsales.com
800-275-4576
Many configurations are available
for this drive; we like the price/
performance balance of the 120GB,
FireWire 400, 5,400 rpm model.

Style

Style

My Book Pro Edition
$349.99 (500GB) Western Digital
www.wdc.com 949-672-7000
This 7,200 rpm, 500GB drive
includes FireWire 800, FireWire
400, and USB 2.0 ports; a hypersturdy case; and a ring of blue
LEDs that indicate the amount of
drive space you’ve used.

SimpleDrive Portable Storage
$99.99 (40GB) SimpleTech www
.simpletech.com 800-367-7330
Yes, it is possible for a hard drive
to be sexy, as this Pininfarinadesigned cutie proves—but it’s
not perfect: It has a poky USB
2.0 connection and its bundled
StorageSync software is PC-only.

Rick Oldano has been a pro photographer longer than he cares to admit, Andrew Tokuda’s video-production business is going
gangbusters, Roman Loyola has reviewed printers since the early ’90s, and Rik Myslewski is fascinated by spinning storage thingies.
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SUR
PR
ISE!
Nine things
you may not
know about
your Mac
by Niko Coucouvanis,
Logan Kugler, and
Rik Myslewski

Everyone has
secrets—even your
Mac. Well, “secrets”
may be too strong a
word; how does “littleknown talents” work
for you? Did you know
that your Mac can
help you create new
keyboard shortcuts in
most apps? That it can
proofread—out loud?
Are you familiar with
its security tricks? Its
self-repair skills? Come
along with us as we
uncover some of your
Mac’s more exotic
capabilities. They may

not all be new to you, but
we’re willing to wager that by
page 36 you’ll have said “I
didn’t know that!” more than

a couple of times—and that
the next time you approach
your beloved Mac, it will be
with even more respect.

ON THE

DISC

AppZapper 1.7.0
Maintidget 1.1
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You Can Create Your Own Keyboard Shortcuts

Y

Keyboard shortcuts are great productivity
boosters—especially when you create your own.

our Mac’s mouse is great and all
that, but reaching and clicking can
be a time sink. Luckily, your Mac has
a riot of keyboard shortcuts just waiting to
enhance your productivity. For example, did you know that
you can instantly access any application’s Preferences by
pressing Command-, (comma), or open a selected folder and
all its subfolders in List view by pressing Option-CommandRight Arrow? Now you do—and you can discover many more
such time savers in Apple’s tech note number 75459; check
it out at the euphoniously named http://docs.info.apple
.com/article.html?artnum=75459.
Even better, if you
don’t find a shortcut
for the action you want
shortcutted, you can create
your own. Launch System
Preferences > Keyboard &
Mouse. Click the Keyboard
Shortcuts tab and then
click the plus-sign icon at
Click Add, and Microsoft Word
the bottom left. A pane will
will display the Save As pane
drop; in its Application
when you press Control-S.

pull-down menu, choose the application that you want
to create a keyboard shortcut for and then type the exact
name of the menu command that you want shortcutted.
For example, if you want to create a shortcut for Save As in
Word, you need to add the ellipsis after As (i.e., Save As…).
Then click your cursor in the Shortcut field and enter the
key-combination you want to use. Click the Add button and
you’ve just programmed a keyboard shortcut; the next time
you open that app, it’ll have your new shortcut. (Disclaimer:
In our experience, this technique works with most apps, but
not all, and sometimes we had to first open and close the
menu that the command was in before the new keyboard
command would activate.)
To remove a keyboard shortcut, scroll to the bottom of the
list in System Preferences > Keyboard & Mouse > Keyboard
Shortcuts, where you’ll find a section entitled Application
Keyboard Shortcuts. Select the shortcut you want to cut
short and click the minus-sign icon; the next time you open
the app it’s related to, the shortcut will have vanished.

YouR MAC CAN repair itself

L

Third-party disk utilities can be a godsend, but first
let your Mac try to heal itself.

ike you, any computer benefits from
good hygiene practices, but your
Mac brings its own toothbrush—it’s
called Disk Utility (/Applications). Simply
using it to repair disk permissions fixes a surprising number
of problems. To do so, Launch Disk Utility, select your startup
volume in the list on the left, click the First Aid tab if it doesn’t
auto-select, then click Repair Disk Permissions, and wait until
the process is completed. (Skip the Verify Disk Permissions
button—why bother if you want to repair them anyway?) You’ll
notice that you can’t repair permissions on volumes that don’t
have Mac OS X installed on them. So, who said life is fair?
You also have help for more-serious problems, such as
your Mac refusing to start up at all, and that help is again
Disk Utility—but we’re
talking about the copy
on the Mac OS X install
disc that came with
your Mac. Put that disc
in your Mac’s optical
drive, and then start
up while pressing the
C key—and be patient,
since starting up from
the optical drive takes
time. Select Utilities >
Disk Utility; when
Disk Utility reports that this drive
Disk Utility launches,
was only mildly unhealthy.
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select your recalcitrant startup volume, click the First Aid
tab if need be, and then click Repair Disk. Don’t mess with
permissions this way—that install disc doesn’t know what
files have permissions for what. Run Repair Disk twice, first
on the volume and then on the drive it’s on.
You can repair a volume without your Mac OS X install
disc, but it requires a trip to your Mac’s pure-Unix
command-line interface: a dark, scary place where there’s
no Command-Z undo and you have to use your fingers for
typing, not pointing the mouse. Ready? Shut down your Mac,
then start it back up. As soon as you hear the startup chime,
press Command-S to enter Single-User mode. A Unix prompt
will eventually appear—if you get stuck in a cascading loop
of repetitive text, press Return once or thrice, and the prompt
should appear. You’re now deep in the unprotected bowels
of Unix—don’t get fancy, because one false move could bring
disaster. Instead, just type /sbin/fsck -fy and press
Return (fsck stands for file system check). Your Mac will run
a rather lengthy checkup on itself, and then, if anything’s
wrong, it will let you know and take a whack at fixing things.
When it informs you that all’s well, it never hurts to type
/sbin/fsck -fy and press Return again, just to make sure.
When both you and your Mac are happy, type Reboot, press
Return, and you’ll return to the good ol’ Mac OS X interface.

RSPU
US !P
S
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Mac OS X Has a Solid Built-in Word Processor

M

Once merely a replacement for the venerable
SimpleText, TextEdit is now all grown up.

ac OS X includes a surprisingly
capable word-processing app:
TextEdit (/Applications). Here are
just a few of our favorite TextEdit tricks;
more can be discovered in its Help system—and yes, TextEdit
can save in Word’s .doc file format.
Styles In the Styles drop-down menu in TextEdit’s Ruler,
you can choose from five predefined styles. Or create your
own and add it to the list by selecting text in that style,
selecting Other in the Styles drop-down menu, and clicking
Add To Favorites. You can also select text with all instances
of any style, change multiple instances, and more.
Tables Making tables in TextEdit is as easy as pie. Choose
Format > Text > Table, and
a table will appear; in its
first cell will be any text in
the paragraph your cursor
is in, so if you want an
empty table, make sure to
press Return first. When
your table appears, so will
the Table palette, in which
It’s easy to customize your
you can enter the number
bullet points in TextEdit’s Lists
of rows and columns you
pull-down menu.

want, choose both horizontal and vertical alignment, merge
and split cells, nest tables in tables, and choose both
background and border color, plus border thickness.
Lists Creating bulleted and numbered lists is easy, too.
Type your list, select it, and then choose the type of list you
want from the List menu in the Ruler. You can also add text or
symbols as prefixes and suffixes to your numbers or bullets
by choosing Other in the List pull-down menu. Your creativity
will be limited to this document—your customized bullets or
numbers won’t appear in a new document’s Lists menu.
Properties You can identify and search for your TextEdit
documents using properties. Select File > Show Properties
(or Command-Option-P). In the Document Properties dialog
that appears, you can add any and all the info you want
Spotlight to be able to search for. A few caveats: Keywords
must be separated by commas; properties don’t apply to
plain-text files; and if you want to avoid the hassle of typing
the Author, Company, and Copyright properties for each
file, you can add them globally to each new document in
TextEdit > Preferences > New Document.

Your Mac Can Help You Proofread

Y

Your Mac can read you a story—which can be
mighty helpful if it’s one you wrote yourself.

ou may already know that your
Mac can talk to you; what you
may not know is how helpful its
text-to-speech powers can be when you
need to proofread a document. The reason this is so helpful
is simple: Studies have shown that when we read something
over that we recently wrote ourselves, we often skip over a
double word or an incorrectly placed word because we read
it the way we remember that we wanted it to be read. There
are three solutions to this mind game: First, you could come
back to the document a couple of days later, after you forget
what most of it says. Second, you could ask a friend or a
coworker to proofread it for you. The third solution is the
quickest and easiest
of them all: Have
your Mac read your
document to you.
Before you turn your
Mac into an automated
proofreader, first
make sure that you’ll
be able to understand
it and that it’ll know
when you want it to
start talking. Launch
Trust us—you do not want Hysterical System Preferences >
Speech and select the
to proofread your documents!

Text To Speech tab. Click the Play button, and your Mac will
begin to talk—what it says depends on the voice chosen in
the System Voice drop-down menu. If the speech is close to
unintelligible, choose a more realistic voice—we’re partial to
Victoria and Bruce, but to each his or her own. You can also
choose how fast the voice speaks. Now check the box labeled
Speak Selected Text When The Key Is Pressed, click the Set
Key button to set the key command you want to use to tell
your Mac to start talking, and then close System Preferences.
Now, if you want to listen to your Mac read a Word
document, simply select the text you want your Mac to read,
then press your chosen key command, and the recitation
will begin. If you’ve written your document in TextEdit, you
can either use the same method as you would in Word, or
simply Control-click and choose Speech > Start Speaking in
the contextual menu that appears. Other apps sometimes
put their access to the Start/Stop Speaking commands in
application name > Services > Speech. Experiment—most
text-employing apps can be made to speak up.
By the way, text-to-speech is scheduled for a vast
improvement in the next version of Mac OS X, Leopard,
which is scheduled for release in the spring of 2007. We
sentimentalists hope that Zarvox won’t be out of a job.
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EVEN YOUR MAC’S EYE CANDY IS USEFUL

D

Apple’s Dashboard widgets are a good start, but
the true gems can be found on the Web.

ashboard. For many it’s a love or hate,
or even a love/hate, relationship.
But it can make you a multifaceted
Macster—for example, a weatherman, IT whiz,
mathematician, cartographer, and designer. With Dashboard
you can be all of that and more—but only if you know your
widgets. Here’s a baker’s dozen of the best.
1. AirCompare Track down the best airfare prices. (free,
www.widgetizer.com)
2. AirPort Radar Scan the ether for Wi-Fi signals—a must for
mobile ’Bookers. (free, www.macwireless.com)
3. Blood Alcohol Content Calculator Admitting that this
might be helpful to you is your first step toward recovery.
(free, www.alexjacque.com/bac)
4. CNN News Widget All the news, all the time. (free,
www.ejectmedia.net)
5. ColorBurn Get a new professionally designed four-color
palette each day, complete with hexadecimal values. (free,
www.firewheeldesign.com)
6. GMaps This unofficial interface for Google Maps may
inspire you to get out from behind your Mac once in a while.
(free, www.lokkju.com/blog/index
.php/category/projects/google-maps)
7. iCal Events
Here’s one fewer
The Blood
excuse for missing
Alcohol
Calculator says those important
meetings. (free,
it’s OK for our
editor-in-chief www.benkazez.com)
8. iStat Pro Next
to drive, but
time somebody calls,
he’s taking a
“Status, Gladys?” you
cab anyway.

can easily recite your current IP address, memory usage,
uptime, CPU load, and more. (free, www.islayer.com)
9. Mirror It’s just what you need to check your teeth after a
spinach-salad lunch. (free, www.balooba.se)
10. PCalc Use this when your calculations just have to use
Reverse Polish Notation—and for a whole lot more. ($19,
www.tla-systems.co.uk)
11. Sunlit Earth It’s 11:00 p.m.—do you know where your sun is?
(free, http://astronomy.physics.tamu.edu/Widget/SunlitEarth/)
12. WeatherBug Local Weather We don’t need no steenkeen’
Weather Channel! (free, www.weatherbug.com)
13. YouTube Widget Get instant access to all the content
on the greatest thing since sliced bread. (free, www.sportmonkey.com)

MAKE YOUR OWN WIDGET

When Dashboard first appeared in April of 2005, making your
own widget wasn’t exactly easy. Today, with applications
such as Widget Maker X ($16.50, www.lajdesign.com) and
Wcode ($15, www.widgetfactor.com), the task is much easier.
And Leopard (Mac OS X 10.5) will include two technologies
to further improve the lives of widgeteers: Dashcode and
Web Clip. Dashcode is a widget-building tool that includes a
collection of widget templates into which you can drag RSS
feeds, links, and the like to create your own custom, fully
functional widgets—it even includes a debugger. Web Clip is
even easier, but it doesn’t create custom widgets. Instead, you
set a Safari page to open in Dashboard, and then clip that page
to show only the content you want. Bonus: The clip remains live,
refreshed, and interactive. May a thousand widgets bloom!

YOU CAN REINSTALL MAC OS X AT WARP SPEED

Y

Your Mac is only human—sometimes it needs a kick in
the pants. Here’s how to do that quickly and efficiently.

ou’ve tried every trick in “Your
Mac Can Repair Itself,” p32,
and you’re still staring blankly
at the spinning beach ball of doom,
the dreaded international “No!” icon (which replaced the
equally dreaded broken-folder icon in Mac OS 10.2), or the
kernel-panic Curtain of Death. It’s time to admit it: You need
to reinstall your system.
But that takes forever, right?
Not so, Joe—here are the Mac OS X
Installer’s hidden options that can
both speed up the process of getting
your Mac back on its feet and save
space on your hard drive.
ARCHIVE AND INSTALL By using
Mac OS X’s Archive And Install
If all you see when
option, you can get the benefits of
you start your Mac is
this, it may be time to a fresh system and still save the
reinstall your system. time and hassle of reinstalling and

34

December 2006

reregistering your software and resetting most preferences.
Pop your installer disc into your Mac’s optical drive and
restart while holding down the C key. The installer will
automatically launch after your Mac restarts; choose your
preferred language, click the arrow button, pick the volume
you want to install your new system on, agree to the various
legal mumbo jumbo, and then click the Options button in
the dialog that (finally) appears. In the pane that appears,
select Archive And Install and check the Preserve Users And
Network Settings check box. Now, when you install, your user
files will remain untouched and a good chunk of your system
settings will be rolled into a folder called Previous Systems.
You can’t start up from this system folder, but it will
contain all the old system’s preference files and other
important stuff you might need, and it will save you the time

RSPU
US !P
S
!RU
and hassle of reinstalling many, if not all, of your current
applications. Note that if you checked the Preserve Users
And Network Settings check box, you might infect your new
system with whatever was plaguing your old system, but the
time and aggravation saved by doing so makes it worth the
risk. If you reinfect your system, just install it again with this
box unchecked.
Trim your installation A full installation of Mac OS
X contains all of the system’s text items in 15 different
languages—and odds are you don’t speak all of them. So to
speed up your installation and save space (the languages
other than English take up 1.1GB total), disable the ones
you don’t need. After you get past the Install Options page
and click the Continue button, you’ll see a Customize button
in the next dialog; click it, click the disclosure triangle next
to Language Translations in the pane that appears, and
then uncheck any and all languages that you’ll never use.

Brazilian Portuguese, anyone?
Also click the disclose triangle next to Printer Drivers and
uncheck any printer drivers you’ll never use. If, for example,
you know you’ll never have an Epson (652MB), Canon
(345MB), or Lexmark (299MB) printer, you can save nearly
1.3GB of disk space and speed your installation process.
To continue, just click Install, then sit back and enjoy a
snappy installation.

QUIT THE SETUP ASSISTANT

After a few system reinstalls during which you didn’t check the
Preserve Users And Network Settings check box, you’ll grow to
hate the Mac OS Setup Assistant. Well, you don’t have to suffer
through it—you only have to sit through the opening song and
dance; once the assistant gets to the first data-input screen,
simply press Command-Q to quit the assistant. Only do this if
you’re a power-user type who knows how set up your Mac to
use available printers, networks, and the like.

Your Mac Has CIA-Level Technology

W

If you’ve got something to hide—be honest, now—
your Mac can help you hide it. Permanently.

hether you’re an undercover op
seeking the ultimate in security
for an upcoming project, or just
a normal civilian looking to impress your
password, odds are that your files are totally, completely,
friends by sending them password-protected files, your Mac
and irrevocably hosed.
can help. Here’s how to step up the security for your next
Delete Securely Simply trash-and-delete something
top-secret enterprise.
Encrypt Files If you have an important file that you’re
in today’s day and age, and nine times out of 10 it can
be recovered. It doesn’t take a crypto-wizard to find it,
looking to spice up with a little bit of security, encrypting
either—your teenager’s nosy friend could probably do it.
the file with a password is quick and easy. Simply open the
So to increase the odds that something you delete doesn’t
file that you want to encrypt, select File > Print, then click the
come back to haunt you, there are a couple of things you
PDF button at the bottom-left corner of the Print window,
can do. First off and most simply, if there’s a single item or
and select Encrypt PDF. Supply a password and you’ve just
even many things on the hard drive that you want to delete,
created a locked copy of the document—the original remains
just place it in the Trash, go up to Finder in the menubar, and
unlocked on your Mac.
scroll down to Secure Empty Trash.
Use File Vault Initiating a full system lockdown is easyIf you’re selling your Mac, you’ll want to erase the entire
cheesy with File Vault—maybe a little too easy, considering
hard drive, and if there’s something on the drive that you
that there’s no easy way to bust back in if you forget your
really, really, really don’t want anyone to find—ever—open
password. Located in System Preferences > Security,
Disk Utility (/Applications/
File Vault can encrypt all of
Utilities) and select the Erase tab.
the files in your home (user
Click on the volume you’re looking
name) folder and make them
to nuke in the left-hand list and
accessible only if you type
then click Security Options. Now,
in a master password that
will a seven-times overwrite
you’ve set. It also allows you
suffice, or do you need the full 35to set up a number of other
pass hyper-obliterator? And yes,
security features including
the seven and 35 passes mean
automatic logout after a
that the process will take seven or
specified number of minutes of
35 times as long as a simple zeroinactivity, disabling automatic
out, respectively—and that can
login, requiring a password
be a long, long time, depending
to wake from sleep or your
upon the size of your drive. Have
screen saver, and requiring
a terabyte drive and want to do
a password to unlock each
the full 35-pass erase? Take a
secure system preference. Use
File Vault with care, however— Click the question-mark icon, and File Vault will suggest a vacation to Tierra del Fuego while
your Mac churns away.
if you forget that master
password ranging from simple to diabolical.
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There’s More Than One Way to Eject a Disc

Y

Got a disc stuck in your optical drive? Don’t panic—
just follow these escalating eviction procedures.

ou have a CD or DVD in your Mac’s
optical drive that you want out of your
Mac’s optical drive—simple, right? All
you need to do is select the disc’s icon and
drag it to the Trash—but sometimes the disc is stubborn and
won’t eject. If that’s your problem, try the steps below.
1. Select the icon and press Command-E. If it’s still a no-go…
2. …launch Disk Utility (/Applications/Utilities), select the
recalcitrant disc in the volume list on the left, and then either
click the Eject button, press Command-E, or choose File >
Eject Disk. If the disc is still being stubborn…
3. …restart while holding down the mouse button. No? Then…
4. …if you have a tray-loading optical drive, shut down your
Mac or put it to sleep, pry or slide open the drive’s protective
door, find the emergency-eject hole on the front of the drive
(its location varies
from drive to drive, and
CD stuck in your
some drives don’t have
optical drive?
one at all), and poke a
Sometimes Disk
straightened paper clip
Utility’s Eject
button can help. into the hole—firmly—

until the disc pops out. If you can’t use this method ’cause
your drive is slot-loading or is missing that helpful hole…
5. …it’s time for your last resort, short of taking your Mac to
an Apple Authorized Service Provider: ejecting the disc using
an Open Firmware command. But before you try this, know
that this trick doesn’t work on all Macs; in fact, it doesn’t
work on any Intel-based Macs. To access the mighty—and
mighty bland—Open Firmware interface, restart your Mac; as
soon as you hear the startup chime, hold down CommandOption-O-F. A white text-based screen will appear that’ll
either prompt you to release the keys or simply display an
ok prompt. At this prompt, type eject cd (even if it’s a DVD
that’s stuck in your drive). Press Return, and in a second
or two your disc will—should?—pop out of the drive and
another ok prompt will appear; type mac-boot, press
Return, and your Mac will resume its startup sequence until
you’re greeted by a normal desktop.

Your Mac Runs Better on Empty

T

Well, not “empty,” per se, but your Mac will definitely
run snappier if your hard drive’s not stuffed.

here comes a time when you
need to invest a bit of it—time,
that is. If you can put aside a
good portion of a day or maybe even
a weekend to delete unnecessary files and apps from your
hard drive, there’s a good chance that it’ll make your Mac
run snappier, plus save you a few bucks that you’d otherwise
spend on a larger drive. It’s not a particularly pleasant
chore, so schedule it for when there’s a good game on the
radio; and no, we don’t mean the Raiders versus the Bengals
(unless, of course, you live in Cincinnati).
ZAP YOUR APPS We recommend starting with your
Applications folder; you can often get rid of some hefty
apps that you never use. Open that folder in list view and
press Command-J; in the dialog that appears, click the This
Window Only radio button and the Calculate All Sizes check
box. Wait for a bit until your file and folder sizes have all
been calculated,
then click the Size
column to sort your
apps from fattest to
most anorexic. Now
all you need to do is
drag any chubby app
you don’t need to the
Trash. Better yet, get
a copy of AppZapper
($12.95, on the Disc
Sorting your apps from chubby to
or www.appzapper
trim makes it easier to weed out the
.com), which also
unwanted plus-sizers.
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gets rid of most apps’ preference files, caches, and other
associated files.
GET THE PICTURE AND FLICK THE FLICK Next weed out your
Pictures and Movies folders in the same way. If you’re like
us, you have thousands of pictures you’ve pulled from the
Web during the past decade, plus cute QuickTime flicks you
just had to watch—once. Admit it, that kitty-attack WMV file
was fun last year, but now it’s just eating up space.
trash carefully Remember that there are some folders
you don’t want to mess with because their contents are
required to keep Mac OS X running smoothly. Do-not-touch
folders include those named Library and System. You can,
of course, delete unwanted fonts from /Library/Fonts and
preference (plist) files and application-support files for apps
you no longer have from /Library/Preferences and /Library/
Application Support, but tread lightly. One simple rule: If you
don’t know exactly what you’re trashing, don’t trash it.

YOUR MAC CAN AUTO-TRASH

Late at night, your Mac automatically runs a series of important
maintenance scripts that, among other things, get rid of spacehogging log files and caches. However, if you turn your Mac
off at night—or even put it to sleep—it won’t run ’em. The good
news is that there’s a Dashboard widget named Maintidget
(free, on the Disc or www.giantmike.com) that allows you to run
the daily, weekly, and monthly maintenance scripts any time
your little heart desires.

MacAddict’s how-to editor, Niko Coucouvanis; MacAddict’s editor-in-chief, Rik Myslewski; and just
plain Mac addict Logan Kugler are all chagrined that their Macs are so much smarter than they are.

Field Guide to Word keyboard commands

Command Key
Key Commands
by Rik Myslewski

U

sing your mouse to select text, style paragraphs, insert breaks, and otherwise process words is all
well and good, but Microsoft Word also provides plenty of ways to live a mouse-free existence. Here
are a cool 108 of our favorite time-saving key commands—and we didn’t even bother with Command-S,
Command-C, Command-P, and all the rest of the basics that every Mac addict already knows. Learn even a
fraction of these power pecks, and your productivity will soar.

STYLING
1.5-Line-Spaced Paragraph

Command-5

All Caps1

Command-Shift-A

Apply List Bullet

Command-Shift-L

Change Case1

Shift-F3
Command-Option-C

Display Style Toolbar

Command-Shift-S

Double Underline

Command-Shift-D

Double-Spaced Paragraph

Command-2

Grow Font

Command-Shift-. (period)

1

2

Grow Font One Point2

Command-]

Shrink Font2

Command-Shift-, (comma)

Shrink Font One Point

2

Command-[

Single-Spaced Paragraph

Command-1

Small Caps1

Command-Shift-K

Subscript1

Command-=

Superscript

Underline Entire Word1
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Command-T

Indent

Control-Shift-M

Page Break

Shift-Enter

Section Break

Command-Enter

Time

Control-Shift-T

JUMP TO...
Bottom of Window

Command-Option-Page Down

End of Column

Control-Page Down

End of Document

Command-End

End of Line

End

Option-End
Command-Right Arrow
Control-Down Arrow
Option-F7

Command-Shift-W

Next Open Document

Command-F6

One Paragraph Down

Command-Down Arrow

Command-Option-A

Other Pane in Split Document

Shift-F6

INSERT...
Comment

Control-Shift-D

Hanging Indent

Next Misspelled Word

Command-Shift-=

1

Date

Option-F6

JUMP TO... (continued)
Previous Open Document
Start of Document

Command-Shift-F6

One Line Up

Shift-Up Arrow

Option-Shift-F6

One Paragraph Down

Command-Shift-Down Arrow

Command-Home
Option-Home

Start of Line

Option-Shift-Down Arrow
One Paragraph Up

Command-Shift-Up Arrow

Home

Option-Shift-Up Arrow

Command-Left Arrow

One Word Left

Control-Up Arrow

One Word Right

Option-Shift-Right Arrow

To Bottom of Window

Command-Option-Shift-

MOVE CURSOR...	 
One Line Down

Down Arrow

One Line Up

Up Arrow

One Paragraph Down

Option-Down Arrow

One Paragraph Up

Command-Up Arrow
Option-Up Arrow

One Word Left

Option-Left Arrow

One Word Right

Option-Right Arrow

OPEN...	 
Find Dialog

Command-F

Font Dialog

Command-D
Command-Shift-F

Go-To Dialog

Command-G

Help

Command-/

Hyperlink Dialog

Command-K

Macro Dialog

Option-F8

Option-Shift-Left Arrow

Page Down
To End of Document

Command-Shift-End

To End of Line

Shift-End
Command-Shift-Right Arrow

To Start of Document

Command-Shift-Home

To Start of Line

Shift-Home
Command-Shift-Left Arrow

TABLES	 
Delete Row

Command-Control-X

Extend Selection to End of Row

Option-Shift-End

Insert Row

Command-Control-V

Jump to End of Row

Control-End

Select Entire Column

Option-Shift-Page Down

Select Entire Table

Option-Clear
Command-Option-T

Notebook-Layout Dialog

Command-Option-B

ET CETERA	 

Paragraph Dialog

Command-Option-M

Copy to Scrapbook 3

Command-Shift-C

Preferences Dialog

Command-, (comma)

Create a Footnote

Command-Option-F

Print-Preview Window

Command-F2

Create an Endnote

Command-Option-E

Command-Option-I

Hide Text1

Command-Shift-P

Look Up in Reference Tools

Option-Shift-F7

Minimize Document

Command-M

Project-Gallery Dialog

ALIGN PARAGRAPH...	 
Center

Command-E

Justified

Command-J

Left

Command-L

Right

Command-R

DELETE...	 

Control-Shift-H
2

Paste Selected Scrapbook Item3 Command-Shift-V
Repeat Find

Shift-F4
Command-Shift-F4
Command-Option-Y

Show Thesaurus Entry4

Shift-F7
Command-Option-R

Split Document

Next Word

Command-Option-G

Previous Word

Command-Delete

1 Toggle

Option-Delete

3 Only

1

Command-Option-S

2 Selection

or word cursor is in
when Scrapbook is open
or adjacent word

4 Selection

EXTEND SELECTION...
One Character Left

Shift-Right Arrow

One Character Right

Shift-Left Arrow

One Line Down

Shift-Down Arrow

Rik Myslewski, MacAddict’s editor-in-chief, secretly pines for
the days of MicroPro’s WordStar, when all commands were
key commands.
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3DX Technologies’ Banshee (pictured) uses five speakers to create a virtual surroundsound experience. How surroundy is its sound? Turn to page 61 to find out. Next month,
we’ll take a close look at Avid’s Xpress Pro 5.5 video-production software, Pentax’s
K100D SLR camera, Digital Foci’s Picture Porter Elite photo viewer, the TubeSock video
utility, and a lot more.
Reviews
44 1.66GHz Core Duo Mac mini desktop Mac
44 1.83GHz Core Duo Mac mini desktop Mac
44 17-inch 1.83GHz Core 2 Duo iMac desktop Mac
44 17-inch 2.16GHz Core 2 Duo iMac desktop Mac
44 24-inch 2.33GHz Core 2 Duo iMac desktop Mac
56 Alpha DSLR-A100K SLR camera
61 Banshee speaker
53 DSM-G600 Network Storage Enclosure network storage and router
54 FireLite XPress portable hard drive
57 iListen 1.7 speech - recognition software
51 iPod portable media player
50 iPod nano portable media player
60 Mindstorms NXT LEGO robot set
52 Nike + iPod Sport Kit personal trainer
52 Nike+ Sport Armband iPod nano armband
58 Parallels Desktop for Mac Windows-virtualization software
54 PDF Shrink 4.0 PDF utility
62 Point & Shoot Video Camcorder camcorder
49 Quicken Mac 2007 personal - finance software
55 SpeckTone Retro iPod speaker stand
52 Sportsuit Sensor+ Nike + iPod Sport Kit case

Games
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66 Bejeweled iPod game review
67 Championship Manager 2006 coming soon
65 Colin McRae Rally Mac game tips
66 Cubis 2 iPod game review
65 Hearts of Iron II: Doomsday coming soon
67 Heretic Kingdoms: The Inquisition coming soon
66 Mahjong iPod game review
66 Mini Golf iPod game review
66 Pac-Man iPod game review
66 Tetris iPod game review
66 Texas Hold ’Em iPod game review
66 Vortex iPod game review
66 Zuma iPod game review

We’d spend our
own hard-earned
money on this
product.

Universal application
that runs natively on
both PowerPC and
Intel Macs.

December 2006

43

44

REVIEWS

better living through smarter shopping

Core 2 Duo iMacs, just in
time for the holidays.

iMacs and Mac minis
FASTER DESKTOP MACS

N

ot long after the release of the Mac
Pro (
Nov/06, p38), which
completed the whole Intel-ization of the
Mac family, we’re now into the second
generation of Intel-based Macs. The
newest iMacs and Mac minis are sure to
bring smiles to the faces of your family
and friends during the holiday shopping
season. For this review, we took a close
look at the 17-inch 1.83GHz Intel Core
2 Duo iMac, the 17-inch 2.16GHz Intel
Core 2 Duo iMac, the 24-inch 2.33GHz
Intel Core 2 Duo iMac, the 1.66GHz Intel
Core Duo Mac mini, and the 1.83GHz
Intel Core Duo Mac mini. Note that for
this review, Apple provided us with Macs
that were upgraded with either more
RAM or faster processors than their base
configurations, but to avoid confusion
we’ll refer to them by their base-model
prices when we discuss them below.
iMacs. The previous iMac line had
a 20-inch iMac as the top model; 24
inches seems so gloriously indulgent.
We tend to associate the word “iMac”
with compactness, efficiency, and
tidiness, so when the 24-inch iMac
arrived, seeing “iMac” on such a large
box was almost comical.
Measuring 20.6 by 22.6 by 8.1 inches
and weighing 24.7 pounds, the 24-inch
iMac fits on most standard-size desks.

44

December 2006

But is it too big? We found that after a
few weeks of use, 24 inches hits the
display-size sweet spot for serious Mac
users. Compare it to Apple’s 30-inch

24-inch iMac (2.33GHz)
PRICE: $1,999 base model
(2.16GHz), $2,574 as tested
SPECIFICATIONS: (as
tested) 2.33GHz Intel Core
2 Duo processor, 4MB shared L2
cache, 667MHz frontside bus, 1GB RAM,
500GB Serial ATA hard drive, 8x doublelayer SuperDrive, 24-inch LCD (1,920 by
1,200 native pixel resolution), 256MB nVidia
GeForce 7600 GT graphics card, AirPort
Extreme, Bluetooth 2.0, Apple Remote
GOOD NEWS: Gloriously large screen.
Good performance with native Intel
software.
BAD NEWS: 3GB memory ceiling.
Rosetta speed
still slower than
native PowerPC
performance.
COMPANY: Apple
CONTACT: 800-692-7753 or
404-996-1010, www.apple.com

Cinema Display; you can easily have
your thought processes distracted as
you shift in your seat and squint in
search of your cursor while you use that
humongous display. When we’re not
editing a video or manipulating a large
color photo, the 30-inch Cinema Display
can prove unwieldy. Our experience with
the 24-inch iMac, however, was more
comforting, more natural—and we had
all that desktop space to use. Compared
to a 20-inch display, the extra four
inches can make a world of difference,
especially if you have multiple windows
open at the same time, or work in two
or more apps at once. Sitting next to
the 24-inch iMac, the 17-inch iMac is
downright cute—and for most people,
an appropriate size.
At the heart of the new iMacs
are Intel’s Core 2 Duo processors,
the successors to Intel’s Core Duo
processors. Like the Core Duo, the Core
2 Duo has two processor cores—think of
the Core 2 Duo as having two processors
on a single chip. Having two cores
on one chip is an advantage if your
software is multithreaded; you’ll get
faster performance as two processor
cores work to complete your single
task. Mac OS X, iLife ’06, and Adobe
Photoshop CS2 are just a few examples
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of multithreaded software.
One major difference between
the new iMacs’ 64-bit Core 2 Duo
processor and the old iMacs’ 32-bit
Core Duo processor is that the Core 2
Duo is based on an entirely different
processor architecture. The upgrades
are many, including the ability to process
a full 33 percent more instructions
per clock cycle, improved power
management, a more intelligent onchip cache, better management of the
data scooting back and forth from the
processor to the iMacs’ RAM, and a new
and faster way of processing mediarich data such as video files. Here’s the
important takeaway: The Core 2 Duo is
one fast puppy.
With all of the iMacs except the
$999 17-inch iMac, you can boost the
processor speed a bit for an additional
fee. For example, instead of a 2GHz Core
2 Duo processor in the $1,199 17-inch
iMac, you can pay an extra $100 and get
a 2.16GHz Core 2 Duo processor. On the
20- and 24-inch iMacs, you can boost
the processor speed from 2.16GHz to
2.33GHz for $250.
The 24-inch iMac has one FireWire
400 and one FireWire 800 port; the 17inch iMacs have a pair of FireWire 400
ports and no FireWire 800 connectors.
All of the iMacs have three USB 2.0
ports, Gigabit Ethernet, an optical digital
audio output/headphone-out jack,
an optical digital audio input/audio
line-in jack, and a mini-DVI output port.
The iSight Webcam is also standard
equipment, and all iMac models except
the $999 17-inch iMac come with an
Apple Remote (the Remote is a $29
option for the $999 17-inch iMac).
At the standard configuration, the
iMacs come with 1GB of memory,
except for the $999 iMac, which has
512MB of memory. The iMacs use
667MHz DDR2 (PC2-5300) SO-DIMMs,
which are smaller than your standard
DIMMs, and they fit into slots located
at the bottom of the iMac (you have to
unscrew and remove a cover to access
the slots). However, there’s a catch when
it comes to the memory: The iMacs have
maximum RAM configuration limits that
don’t jibe with the number of slots and
the maximum amount of RAM you can
get on a SO-DIMM (which is currently
2GB). Theoretically, you should be able
to fill the two slots in the iMac with a
46
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pair of 2GB SO-DIMMs for 4GB of total
memory—but that’s not true with the
iMacs. On the $999 17-inch iMac, the
maximum memory amount is 2GB,
while the other three iMacs have a 3GB
maximum memory amount. According
to Apple, the memory restrictions are
caused by the new iMac hardware. Apple
fills both SO-DIMM slots regardless
of what memory you specify during
your order, so if you want to add more

17-inch iMac (1.83GHz)
PRICE: $999 base model (512MB RAM),
$1,074 as tested
SPECIFICATIONS: (as tested) 1.83GHz
Intel Core 2 Duo processor, 2MB shared L2
cache, 667MHz frontside bus, 1GB RAM,
160GB Serial ATA hard drive, 24x Combo
drive, 17-inch widescreen LCD (1,440
by 900 native pixel resolution), 64MB
(shared memory) Intel GMA 950 graphics
subsystem, AirPort Extreme
GOOD NEWS: Affordable. Rosetta speed
has improved over the previous generation
of Intel-based iMacs.
BAD NEWS: Lackluster video
performance. No Apple Remote. 2GB
memory ceiling. Rosetta speed still slower
than native
PowerPC
performance.

17-inch iMac (2.16GHz)
PRICE: $1,199 base model (2GHz), $1,299
as tested
SPECIFICATIONS: (as tested) 2.16GHz
Intel Core 2 Duo processor, 4MB shared L2
cache, 667MHz frontside bus, 1GB RAM,
160GB Serial ATA hard drive, 8x doublelayer SuperDrive, 17-inch LCD (1,440 by
900 native pixel resolution), 128MB ATI
Radeon X1600 graphics card, AirPort
Extreme, Bluetooth 2.0, Apple Remote
GOOD NEWS: Good bang for the buck.
Rosetta speed has improved over the
previous generation of Intel iMacs.
BAD NEWS: 3GB memory ceiling.
Rosetta speed
still slower than
native PowerPC
performance.

memory later, you’ll have one or two
spare SO-DIMMs to stash in your drawer
or sell on eBay.
Mac minis. Both Mac mini models
come with Intel Core Duo processors.
The erstwhile Intel Core Solo model at
the low end of the Mac mini line is now
gone, which has some significance: All
of Apple’s Macs now have multicore
processors. Why no Core 2 Duos in the
Mac minis? Cost. The Mac mini is Apple’s
affordable Mac, and a Core 2 Duo
processor pushes the price out of the
range where Apple would like it.
From the outside, both Mac minis
haven’t changed at all. On the back
are a FireWire 400 port, four USB 2.0
ports, DVI output for your display (if your
display has a VGA connector, you’ll be
happy to know that Apple includes a
DVI-to-VGA adapter), Gigabit Ethernet, a
combined optical digital audio input/
audio line-in port, and a combined
optical digital audio output/headphoneout jack.
The standard Mac mini configurations
come with 512MB of memory, and like
the iMacs, the Mac minis use 667MHz
DDR2 SDRAM (PC2-5300) SO-DIMMs,
not full-length standard DIMMs. If you
think you might want to upgrade the
Mac mini’s memory later, be prepared
for some handiwork. The Mac mini
doesn’t use any screws to keep itself
closed; the case has internal latches
that snap into place to keep it fitted
together snugly. To open the Mac mini,
you need to slide a putty knife between
the seams of the case and gently pry it
open. With an easy but firm touch, you
can get it open. After that, you need to
disconnect a few cable connectors and
then remove four screws that attach the
drive-bay structure to the Mac mini’s
base—the memory slots are underneath
this assembly. If any of what we just
described sounds even a bit daunting,
then spend the extra money and get as
much RAM as you can afford installed
at the point of purchase.
To gauge the speed of the new Macs,
we performed a suite of benchmark
tests. All of the new Macs were tested
with 1GB of RAM. For the specifications
of the Macs we tested, read the gray
specification boxes.
iMac testing. The new top-of-theline 24-inch iMac beat the now-defunct
20-inch 2GHz Core Duo iMac in all of our

06fip277_SS_MAC Ad_1PG_Mac Addic1 1
06fip277_SS_MAC Ad_1PG_Mac Addic1 1
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10/2/06 3:00:23 PM
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tests. The 24-inch iMac was 46 percent
faster when exporting a movie in iMovie
HD; 30 percent faster when importing
196 JPEGs into iPhoto; 40 percent faster
when converting 11 WAV music files to
AAC; 17 percent faster when sending a
song from GarageBand to iTunes; and 12
percent faster when creating a OneStep
DVD in iDVD. Quite impressive.
The new $999 iMac offers a good
speed boost over its predecessor,
the 17-inch 1.83GHz Core Duo
iMac. The $999 iMac was faster
in our iMovie HD Sepia Tone Video
FX test by 6 percent, and 1 percent
faster when sending a song from
GarageBand to iTunes, but it
was a full 44 percent faster when
exporting a movie in iMovie HD, and
21 percent faster in our iPhoto JPEGimport test.
But Apple offers two 17-inch iMacs
with Core 2 Duo processors. Which one
to get? For an extra couple of hundred
dollars, the speed gains are slight, in
some cases. The $1,199 iMac bumped
up to a 2.16GHz processor for a hundred
more bucks was 7 percent faster than
the $999 iMac in our iMovie HD Sepia
Tone Video FX test, 4 percent faster
when exporting a movie in iMovie HD,
14 percent faster when sending a song
from GarageBand to iTunes, and 10
percent faster in our iTunes WAV-to-AAC
file-conversion test. But it’s not all about
speed—you get a lot more for the extra
cash, such as a faster processor, a larger
L2 cache, more memory, a double-layer
SuperDrive, a dedicated 128MB ATI
Radeon X1600 graphics card, built-in
Bluetooth, and an Apple Remote.
Mac mini testing. The new $599 Mac
mini used to reside on top of the Mac
mini line. It’s now the lower-end mini,
with a sibling $799 mini that offers a
slight speed improvement. The $799
mini was 7 percent faster than the $599
mini when creating a disc image in iDVD,
6 percent faster in our iMovie HD Sepia
Tone Video FX test, 4 percent faster
when importing JPEGs into iPhoto, and
5 percent faster in our iTunes WAV-toAAC conversion test. In our GarageBand
Send-to-iTunes test and our iMovie HD
video-export test, the two Mac minis
had similar speeds.
You face an interesting choice if you’re
deciding between the $799 Mac mini
and the $999 iMac. For the extra $200,
48
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the iMac provides a built-in display, a
Core 2 Duo processor, and a bigger hard
drive. The Mac mini, on the other hand,
has a less powerful Core Duo processor
and a smaller hard drive, but also has

Still a li’l
Mac, but just a
li’l faster.

Mac mini (1.66GHz)
PRICE: $599 base model, $674 as tested
SPECIFICATIONS: (as tested) 1.66GHz
Intel Core Duo processor, 2MB L2 cache,
667MHz frontside bus, 1GB RAM, 60GB
Serial ATA hard drive, 24x Combo drive,
AirPort Extreme, Bluetooth 2.0, Apple
Remote
GOOD NEWS: Affordable.
BAD NEWS: Difficult to upgrade memory.
Rosetta speed
still slower than
native PowerPC
performance.

Mac mini (1.83GHz)
PRICE: $799 base model, $874 as tested
SPECIFICATIONS: (as tested) 1.83GHz
Intel Core Duo processor, 2MB L2 cache,
667MHz frontside bus, 1GB RAM, 80GB
Serial ATA hard drive, 8x double-layer
SuperDrive, AirPort Extreme, Bluetooth 2.0,
Apple Remote
GOOD NEWS: Nice speed boost over the
previous generation.
BAD NEWS:
Difficult to
upgrade memory.

two features not found on the $999
iMac: a double-layer SuperDrive and
Bluetooth. If you’re an aspiring home
videographer on a tight budget, you can
save some money with the $799 Mac
mini (the DVD-burning SuperDrive is
key), though you’ll have to provide your
own display, keyboard, and mouse,
and sacrifice some speed.
The $999 iMac, on the other
hand, is not only a great first
computer, but could also play a
supporting role as a second Mac
in your kitchen or living room.
Rosetta. The good news:
Thanks to the new iMacs’ Core 2
Duo processors, non-Intel-native
applications using Apple’s Rosetta
translator get a speed boost. For
example, in our Photoshop Actions test,
the $999 iMac was 9 percent faster than
the older 17-inch 1.83GHz Core Duo
iMac. In our Photoshop Elements Auto
Smart Fix test, the same $999 iMac was
an impressive 16 percent faster than the
older 17-inch 1.83GHz Core Duo iMac.
The bad news: Non-Intel-native software
using Rosetta still runs slower on these
Intel-based Macs than on their PowerPCbased counterparts. We ran the same
tests on a 17-inch 1.9GHz PowerPC iMac
G5; in our Photoshop Actions test, the
iMac G5 was 20 percent faster than
the $1,199 iMac and 16 percent faster
than the $1,999 iMac. In our Photoshop
Elements test, the iMac G5 was 6
percent faster than the $1,199 iMac,
and it tied the $1,999 iMac.
You’ll be hurtin’ for certain if you use
a non-Intel-native application on a Mac
mini on a regular basis. The old 1.42GHz
Mac mini G4 was 20 percent faster
than the $799 Mac mini and 43 percent
faster than the $599 Mac mini when
performing the Photoshop Action test.
The bottom line. Our favorite new
Mac is the 24-inch iMac. For serious
hobbyists, or professionals on a budget,
the 24-inch iMac is an ideal Mac—and
while you’ll still take a performance
hit when using non-Intel-native
applications, the new processors do a
lot to improve Rosetta’s performance. If
you’re looking for a Mac mini, get
as much RAM as you can afford since
both Mac minis share their memory
between the video subsystem and the
main processor. The more memory,
the better.—Roman Loyola
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iPod nano

The nano’s Search
function, found under the
Music menu, is easy to use
and includes helpful icons
to distinguish songs from
artists, albums, podcasts,
and audiobooks, so you’ll
be able to tell “Graceland”
the song from Graceland
the album in the search
results. It searches for
the string you entered
anywhere in the title,
not just at the beginning;
entering bla brought up
Blackalicious as well as
Fear of a Black Planet. The
Quickscroll function, which
superimposes the first letter
of items in a list over that
list as you scroll through it
quickly, isn’t as useful as on
the big iPod (p51) because
the nano’s smaller capacity
lends itself to shorter lists.
We found it helpful only
when scrolling through the
Songs list, which tends to be
the longest, and even then,
the letters most frequently
popping up were B and Y,
toward the opposite ends of
the alphabet. You can now also
set a maximum volume so you
don’t reach into your pocket,

THINNER, BETTER DIGITALMUSIC PLAYER

W

ith its brightly colored aluminum
casing, the second-generation
iPod nano looks like a mini iPod mini,
available in silver (2GB or 4GB); pink,
green, and blue (4GB); and black (8GB).
The new case is a vast improvement
over the first-gen nano’s (
Nov/05, p40) easily scratched veneer.
We carried it around in a bag for a
week—crashing up against keys, coins,
a camera, and other potential finishwreckers—and it didn’t pick up a
single mark. Svelte at 3.5 by 1.6
by 0.26 inches and 1.41 ounces,
it’s even slimmer and lighter than
the first iPod nano, and sturdy
enough to survive being sat on by
a 280-pound reviews editor when
it was in his back pocket.
The 1.5-inch LCD is 40 percent
brighter, according to Apple, and
photos look sharp and clear on
it—although the four-by-three grid
of tiny thumbnails is still hard to
see, and you still can’t connect
the nano to a TV. The battery life
has also been improved. On the
4GB model, we got 20.9 hours
of music playback (at 50 percent
volume with the backlight and
Sound Check turned off), and the
8GB model rocked out for a full 24
hours. The redesigned earbuds
sounded much better than the
chintzier old ones, especially on
the low end, although they still
hurt our ears after half an hour and
wouldn’t stay put while jogging.
The other changes are to the iPod
nano’s software, including gapless
playback, which removes the space
between tracks when it shouldn’t have
been there in the first place—especially
nice when listening to concept albums,
live concert recordings, and classical
music. iTunes 7 will analyze your music
looking for gapless albums, but if it
guesses wrong (it didn’t tag any of our

iTunes 7 is required, so if you don’t want to
upgrade, this isn’t the nano for you.

As inspiration for the new iPod nano,
Apple looked to an iPod of the past—the
iPod mini.

Phish or Wilco concerts as being gapless,
for example), you can select the album’s
tracks, press Command-I, and select Yes
in the Gapless Album drop-down menu.

COMPANY: Apple
PRICE: $149 (2GB), $199 (4GB), $249 (8GB)
CONTACT: 800-692-7753 or
REQUIREMENTS: USB-equipped Mac, Mac
408-996-1010, www.apple.com OS 10.3.9 or later, iTunes 7 or later
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accidentally brush the clickwheel, and
blast out your eardrums. One minor
quibble: All the first-generation nano
cases we had lying around either fit
poorly or not at all, but new cases will
be out by the time you read this; plus,
the nano’s aluminum body doesn’t really
need a case to prevent most scratches.
The bottom line. The new iPod nano is
smaller, brighter, tougher, plays longer,
and has double the capacity per dollar.
What’s not to love?—Susie Ochs

GOOD NEWS: Aluminum body. Gapless playback.
Longer battery life. Even slimmer design.
BAD NEWS: No FireWire syncing.
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408-996-1010, www.apple.com
408-996-1010,
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later
7 or later
Clickwheel can be touchy.
Clickwheel can be touchy.
HJA;=2 $249 (30GB), $349
HJA;=2
(80GB)
$249 (30GB), $349 (80GB)
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Nike + iPod Sport Kit
MOTIVATING PERSONAL TRAINER

N

ike and Apple have teamed up to
provide a powerful motivational
tool for both seasoned athletes and
casual runners: the Nike + iPod Sport
Kit. Along with its companion Web site,
www.nike.com/nikeplus, the Sport Kit
tracks your runs, helps you set and meet
goals, and even partners you with others
in group challenges.
The Sport Kit’s hardware includes two
small modules: a sensor that’s designed
to fit into one of the Nike+ line of running
shoes ($85 to $110, www.nike.com/
nikeplus) and a receiver that plugs into
the bottom of your iPod nano (no other
iPods need apply). You can also attach
the sensor to your shoe in other ways,
such as with Marware’s nifty Sportsuit
Sensor+ (below), and the Sport Kit will
work just fine. If you do choose a Nike+
shoe, however, installing the sensor is a
simple matter of lifting the shoe’s insole
and placing the sensor in an indentation
in the sole; after you replace the insole,
you won’t feel the sensor while running.
Calibrating the Sport Kit is equally
simple. Merely use the nano’s Sport
Kit interface to enter your calibration
distance—a 400-meter track is ideal—
and then run that distance; next do the
same with a distance you walk. You’re
done—now you’re ready for a workout.
Again using the nano’s interface, you
tell the Sport Kit whether you want
it to track your distance in miles or

kilometers; you then choose one of three
ways of tracking your run: distance,
time, or calories. Choose kilometers, a
distance run, and a five-kilometer goal,
for example, and during that run your
iPod will announce to you when you’ve
reached each kilometer; count down to
the end of the run when your remaining
distance is 400m, 300m, 200m, and
100m; and then let you know when
you’ve reached your goal—though you
can keep running past your goal, if you’d
like, and that distance will be added to
your run data. If all this goal-oriented
running sounds too stressful, you can

The Nike+ Web site tracks your runs
thoroughly—in this case, a flat run, then
up a steep hill, followed by a walk down.

just run free, and your nano will simply
track your distance and time; you can
also pause the data-tracking during
any type of run—great for red lights at
intersections—and choose to have your
nano not announce your progress.
Back at your Mac, you upload the run

SPORTSUIT SENSOR+

Don’t want to buy new shoes to use the
Nike + iPod Sport Kit? Try Marware’s Sportsuit
Sensor+, a pocket for the Sport Kit’s sensor
New shoes
unit. Pop the sensor into the Sensor+, slip the
not needed.
Velcro closure through your laces, fasten it,
and hit the road. When we inserted the sensor as Marware’s
illustrated instructions indicated, it tracked about half of our
strides; flipping the sensor over fixed the problem.—CM
COMPANY: Marware
CONTACT: 954-927-6031, www.marware.com
PRICE: $9.95

COMPANY: Apple
CONTACT: 800-692-7753 or
408-996-1010, www.apple.com
PRICE: $29
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REQUIREMENTS: iPod nano, Nike+
running shoe or another method of
attaching the sensor to your shoe

Small, light, and highly encouraging.

data from your nano to the Nike+ Web
site (after first creating an account).
Although at times painfully slow, the
site provides a wealth of ways of setting
goals and tracking your progress. You
can, for example, set goals based on
monthly distance, average time, and
pace. When you meet a goal, you’re
rewarded with a virtual medal or trophy
in the My Records section of your
account. You can also get info on all
your runs as a whole, inspect individual
runs in detail, and challenge any other
Nike+ Web member to a race—you run in
your area, your opponent in theirs, and
then you both log back on, sync up your
nanos, and see who won.
The bottom line. Even after only 20
miles, we were hooked on the Nike +
iPod Sport Kit. It has some minor
shortcomings—your chosen music
always ends when your run ends, and
holding down the selection button to
kick in your selected hyper-inspiring
PowerSong is no easy feat while
running—but all in all, we welcome our
new personal trainer.—Carey Myslewski

NIKE+ SPORT ARMBAND

This armband has one fatal flaw. Since the
armband covers your nano’s screen, you must
take your nano out of the armband’s pocket
to navigate through the nano’s menu to both
initiate and finish up a running session—not
only is this annoying, but it increases the
In this armband,
possibility of accidentally inducing run-data your ’Pod is
errors.—CM
running blind.
COMPANY: Nike
CONTACT: 800-379-6453, www.nike.com/nikeplus
PRICE: $29

GOOD NEWS: Works great. Highly motivating. Rich
Web site. Multiple goal and reporting options.
BAD NEWS: PowerSong not easy to activate while
running. Music ends when run ends.
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DSM-G600 Network
Storage Enclosure
UTILITARIAN NETWORK STORAGE AND ROUTER

T

he DSM-G600 is an all-in-one
networking device that combines a
Gigabit Ethernet router, wireless router,
and network attached storage (NAS)
device in a single compact enclosure.
D-Link doesn’t include a hard drive,
but any standard 3.5-inch IDE drive
can easily be installed inside; you can
also use the two USB ports to attach
extra USB hard drives. The device works
by sharing its storage with any attached
Mac or PC, either via Ethernet or over
wireless 802.11g.
The initial setup of the D-Link
enclosure isn’t as straightforward as it
could be—you need to use Microsoft’s
Internet Explorer for Mac Web browser
to set up the DSM-G600 (you can
download IE for Mac at www.pure-mac
;GEH9FQ2 D-Link
;GFL9;L2800-326-1688,
www.dlink.com
HJA;=2 $199.99

.com/webb.html#mie), since
D-Link’s Web interface doesn’t
work with Safari or Firefox. It’s a
bummer because the configuration is
fairly straightforward if you’re familiar
with wireless settings, and formatting
the internal drive as a Windows-based
file system (usable by your Mac, of
course) is completed by pressing one
button. The unit needs to be plugged
into a network where it can pick up a
DHCP address, so, assuming you have
an Ethernet-based DSL or cable modem,
the unit will pick up an IP address, such
as http://192.168.0.2.
The wireless performance, range, and
signal strength are good compared to
other Wi-Fi access points. As for access
to the DSM-G600’s attached storage over

J=IMAJ=E=FLK2 Microsoft
Internet Explorer for Mac, broadband
Internet connection, hard drive

The PC-orientated design is a little ugly,
but network performance is good.

a network, the rate of data transmission
varies depending on how you connect to
the DSM-G600—but if you’re on a fast
Gigabit Ethernet connection, throughput
should be more than satisfactory.
The bottom line. If you have multiple
Macs or a mixture of Macs and PCs, the
DSM-G600 can be a good, always-on,
available-to-everyone repository for your
music, video, and pictures, despite its
restrictive setup requirements.
—Ed Haynes

?GG<F=OK2 A central server for music, movies, etc. Good
network performance and wireless range.
:9<F=OK2 Poor Web-based configuration. Boxy design and
styling. Lack of Mac-mindedness.
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PDF Shrink 4.0

The always-on
LCD has a 158by-120-pixel
area for text.

QUICK-AND-EASY PDF UTILITY

A

FireLite
XPress
MAC-UNFRIENDLY
PORTABLE HARD DRIVE

T

he FireLite XPress portable hard
drive has an LCD that displays
text you’ve entered into the FireLite
XPress Notepad application—it doesn’t
automatically display a list of files. To
preserve your privacy, you probably
don’t want the drive to automatically
display a file list, but it would be nice to
have a choice. You can type in any text
you want (maybe a generic name for your
files, like My Photos), and you can even
draw simple sticklike drawings.
The LCD also displays helpful
information on available capacity—if the
drive is formatted in Windows’ FAT32
(which your Mac can read and write).
When formatted using Mac OS Extended
(Journaled) format, the capacity and free
space on the LCD read 0GB, even when
we had 8GB of files on the drive.
Since the FireLite XPress is USB only,
we weren’t expecting a speedy drive.
Using Xbench (free, www.xbench
.com) to gauge the drive’s speed, we
got results of 11MB per second on
the Sequential Uncached Write and
Sequential Uncached Read tests,
which is about what we expected. Not
bad—but not great, either.
The bottom line. The FireLite XPress
is likable, if you can live with its quirks.
—Roman Loyola
;GEH9FQ2
SmartDisk
;GFL9;L2
239-425-4000,
www.smartdisk.com

HJA;=2 $179.99 (60GB,
tested), $299.99 (120GB)
J=IMAJ=E=FLK2 Mac
OS 10.2 or later, USB

?GG<F=OK2 Helpful LCD display. Bus powered.
:9<F=OK2 LCD text needs
manual updates. Status not
Mac-format compatible.

pago’s PDF Shrink 4.0 is a handy
utility that reduces PDF file sizes.
PDF Shrink took an eight-page, fullcolor PDF created in Adobe InDesign CS2
(using Press Quality settings) and gave
us a 39 percent savings (we used PDF
Shrink’s default settings for print PDFs).
But we noticed that when we printed the
PDF Shrink file, some of our graphics
were blurry. We then adjusted PDF
Shrink to reduce the file but maintain the
original quality—we got a mere 7 percent
savings, but the printed PDF Shrink file
did maintain the quality of the original.
We love PDF Shrink’s Droplets, which
are applets with fixed settings. You
select the settings and click on Save
Droplet, and an applet is made. To
process your files, you can simply drag
and drop the PDFs onto the Droplet. You
do need the original PDF Shrink software
on the Mac you’re using, however.

PDF Shrink can help quickly process
dozens of PDFs.

The bottom line. PDF Shrink is a
helpful utility for mass production of
PDFs. If you regularly use the Print
dialog to create PDFs, PDF Shrink is
an affordable way to make your PDF
file sizes smaller. If PDF creation and
management isn’t part of your daily
routine, or if you use PDFs for press
runs, learn the optimal settings in your
page-layout or PDF-creation software
instead.—Roman Loyola
;GEH9FQ2 Apago
;GFL9;L2
770-619-1884,
www.apagoinc.com

HJA;=2 $35
J=IMAJ=E=FLK2
Mac OS 10.4 or later

?GG<F=OK2 Easy to use. Batch processing.
:9<F=OK2 You’ll need
to rely on Adobe Acrobat or
InDesign for fine-tuning.

** **
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saturation, and big images
printed on Epson’s Stylus
Photo 2200 inkjet printer
showed excellent detail.
The A100K’s sexiest
feature is its antishake
capability, called Super SteadyShot.
It works with any lens, and when
turned on, it shifts the sensor to
cancel out camera movement at slow
shutter speeds. We tried it under three
conditions most likely to produce blurry
images. First, we shot at a very slow
shutter speed in low light. Then, we
racked the telephoto lens out to its
maximum focal length (the shaky, highpowered binocular analogy). Finally, we
shot some extreme close-ups. In each
case we got sharp images at slowerthan-normal shutter speeds that let us
use smaller apertures to better keep
both near and far objects in focus. When
we shot under the same conditions with
the antishake off, most of our images
were unusable. Sony also uses this
feature to shake dust off the sensor
when the camera is powered down.
We got a big kick out of the A100K’s
Sony offers an inexpensive starter
autofocusing system, which uses an
lens that we used to shoot most of our
IR sensor under the viewfinder that
images—a Sony 18mm-to-70mm (27mmtriggers the focusing when you bring the
to-105mm in 35mm terms), f/3.5-5.6 lens
camera to your eye. As for the flash, you
(with an included sunshade) that has a
have to lift it up with your fingertip—
silky-smooth zoom and is extraordinarily
how quaint! On the other hand, you can
sharp. We also had an opportunity to
be sure it will never flash when you
try Sony’s lightweight 11mm-todon’t want it to.
18mm (16.5mm-to-27mm
We slid in the
in 35mm terms), f/4.5camera’s 750-shot
5.6 super wide-angle
rechargeable
lens, which gave us
battery, inserted
visually dramatic
a 2GB SanDisk
pictures with great
Extreme IV
depth of field. Most
CompactFlash card
Minolta lenses will
(you can also use
work, and a line of
Sony’s Memory
Zeiss-made digital
Stick Duo cards with
an included adapter), No, that’s not a Maxxum 5D control panel. glass lenses is on
the way.
and set off to shoot
The bottom line. When Konica-Minolta
local flora and fauna. The camera turned
decided to ditch its camera business,
on in about a second, focus was quick,
you could just hear its Maxxum 5D
shutter lag was a nonissue, and shot-toechoing a Brando-esque, “I coulda been
shot time was as fast as we could click
a contenda!” With Sony now at ringside,
’em, even when using the 3-framesthe rejuvenated A100K definitely has a
per-second continuous burst mode.
shot at the title.—Arthur Bleich
Colors reproduced accurately with good
Sony’s hoping to
get a piece of the
growing SLR pie
with the new
Alpha A100K.

Alpha DSLR-A100K
BUDDING SLR CAMERA

T

he Alpha DSLR-A100K is the first
of a new line of Sony digital SLR
cameras, and this 10.2-megapixel
powerhouse is an in-your-face challenge
to the SLR old boys’ club. It’s the first
SLR released by the Sony and KonicaMinolta collaboration.
Compact and well balanced,
the A100K reduces menu diving
considerably, thanks to its innovative
Function Dial. By turning the dial and
pressing its center button, you can
access metering modes, flash options,
focus, ISO, contrast, saturation,
sharpness, white balance, and control
over the dynamic range of the image.
Each function’s options are displayed on
a 2.5-inch LCD, ready for fine-tuning with
the camera’s rocker switch.
The A100K has a separate mode
dial with six preset scene selections in
addition to the advanced settings. With
a top shutter speed of 1/4,000 second,
continuous shooting of up to three
frames per second, and a flash reach
of more than 40 feet (at ISO 1,600),
there isn’t much that you won’t be able
to shoot.
COMPANY: Sony
CONTACT: 877-865-7669,
www.sonystyle.com
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PRICE: $999.95 with 18-70mm (27-105mm
35mm equivalent) f/3.5-5.6 lens, $899.95
body only
REQUIREMENTS: Mac OS 10.1 or later, USB
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GOOD NEWS: Great ergonomics. Easy to learn. Fine
images. Built-in antishake helps preserve image sharpness.
BAD NEWS: Flash must be raised manually. Mechanically
noisier than others in its class.
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isten 1.7iListen
with Pro
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H9FQ2 MacSpeech
L9;L2603-471-3585,
macspeech.com
=2 $179

T

?GG<F=OK2 Decent
Enables dictation
Decent
directly
accuracy
into rate. Enables dictation directly into
;GEH9FQ2 MacSpeech
J=IMAJ=E=FLK2
Mac OS 10.2.8 J=IMAJ=E=FLK2
Mac OSaccuracy
10.2.8 rate.?GG<F=OK2
many
Mac OS X applications. Powerful
many
yet easy
Mac to
OSset
X applications.
up and use. Powerful yet easy to set up and use.
;GFL9;L2603-471-3585,
or later,
USB
or later,
USB
:9<F=OK2 Accuracy can be affected
:9<F=OK2
by user fatigue.
Accuracy
Error can be affected by user fatigue. Error
www.macspeech.com
correction by voice is tedious. Microphone
correction
placement
by voice
critical.
is tedious. Microphone placement critical.
HJA;=2 $179

M
MacService
The very best for your Mac.

24Hr Mac Laptop Repair - Upgrades - MacService.com - 877.622.3473
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might never
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never
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next version
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called Vista,
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interface
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If you’ve
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VIRTUAL
VIRTUAL
VISTA?
VISTA?

Not that we want to inflict a Windows OS on our Macs, but Parallels makes it painless.
u are actually threading through only

one of the Core 2 Duo’s cores, not
both. As we said, Parallels isn’t about
performance—it’s about convenience.
;GEH9FQ2 Parallels
;GFL9;L2 425-282-6400,
www.parallels.com
HJA;=2 $79.99

And what of Apple’s Windowsrunning Boot Camp beta? The end
result (a Windows OS running on your
Mac) is similar, but the procedure is

J=IMAJ=E=FLK2 Intel-based Mac, Mac
OS 10.4.6 or later, Windows 3.1 or later,
512MB RAM (1GB recommended), 30MB
disk space (15GB recommended)

vastly different: Parallels runs as an
application on your Mac (you’re running
Windows within Parallels, which is
running on your Mac), while Boot Camp
requires you to restart the Mac in pure
Windows mode—you can’t switch back
and forth between Mac and Windows on
the same desktop. Advantage, Parallels.
Boot Camp comes out ahead of Parallels
in the performance department, but
we live in Mac OS, where Parallels’
convenience trumps Boot Camp’s
performance—your mileage will vary
according to your needs.
The bottom line. In a few months,
Boot Camp support will come
preinstalled with Mac OS 10.5, but
nobody outside Cupertino knows quite
how that’ll pan out. In the meantime,
if you need to use Windows software
occasionally and you don’t expect
blistering-fast performance, Parallels
Desktop for Mac is an excellent
compromise.—Niko Coucouvanis

?GG<F=OK2Use Windows without buying a Piece of Crap
(PC). No disk partitioning or rebooting necessary.
:9<F=OK2It’s still Windows. No hardware 3D acceleration.
Assorted growing pains.

December 2006

59

Mindstorms NXT
ENJOYABLE LEGO ROBOT SET

L

EGO’s Mindstorms NXT is 577 pieces
of the LEGO goodness that you
grew up with, but it’s now designed for
digitally influenced imaginations.
Mindstorms NXT is a
robot-building kit. You can
build robots with arms, claws,
wheels, and more, but the
core of the Mindstorms NXT
kit is the Intelligent Brick that
holds programs used to make
your robot perform. The Brick
has connectors so you can
attach robot parts to it,
four sensors (light, sound,
touch, and ultrasonic) to
help your robot react, and
three servomotors for
movement.
The kit says it’s
for kids 10 years
old and older,
but what makes
Mindstorms
NXT feel like a
toy for grown-ups
is its software, which
you use to program the
robot actions. It’s not
kids’ software, so don’t
expect cartoony icons—your kid
will be helpless if you just plop him or
her in from of the app. It takes time to
learn the software, but it does come
with preprogrammed actions so you
can get some satisfaction while you’re
learning. You upload the robot actions
by connecting the Brick to your Mac
via USB. Running the actions on the
robot simply takes a few pushes of the
Brick’s buttons.
We found the greatest pleasure in
constructing our robot—it’s so satisfying
to figure out which pieces to use, snap
the LEGO pieces together, and watch
;GEH9FQ2 LEGO
;GFL9;L2800-453-4652,
http://mindstorms.lego.com

Currently patrolling our editorial offices,
pestering late editors.

your creation take shape. You can
improvise, plan your own, or go to http://
mindstorms.lego.com and use one of
LEGO’s sets of building instructions.
LEGO even offers hardware and software
development kits on its Web site.
The bottom line. Mindstorms NXT
is the bridge between our newfound
adolescent glee and our current tech
lifestyle. Fun, fun, fun.—Roman Loyola
HJA;=2 $249.99
J=IMAJ=E=FLK2 Mac OS 10.3.9 or later, USB,
300MB hard disk space

?GG<F=OK2 LEGO goodness combined with simple robotics—what
we always wanted as kids.
:9<F=OK2 Pricey. Software has steep learning curve.
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;GEH9FQ2 3DX ;GEH9FQ2
Technologies 3DX J=IMAJ=E=FLK2
Technologies
J=IMAJ=E=FLK2
Any device with Any ?GG<F=OK2
device with
:9<F=OK2
No true
:9<F=OK2
iPod dock.No
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true audio
iPod dock.
results.
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Distortion
audio results. Distortion
;GFL9;L2312-474-6108,
;GFL9;L2312-474-6108,
an audio-out or headphone
an audio-out
jackor headphone
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at high volume levels.
at high volume levels.
www.bansheeaudio.com
www.bansheeaudio.com
HJA;=2 $129
HJA;=2 $129
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Point & Shoot Video Camcorder
SURPRISING PORTABLE DIGITAL VIDEO RECORDER

T

he Point & Shoot Video Camcorder
is only four inches tall, weighs four
ounces, and comes with a four-page
manual. You could say our expectations
were small, as well—we weren’t
expecting the Point & Shoot Video
Camcorder to replace a traditional
camcorder. But in about four seconds we
were pointing and shooting, the good
times rolled on and on, and the Point &
Shoot left a big impression.
The Point & Shoot looks more like a
still camera than a video camera, though
it has basic camcorder controls: record,
play, and delete buttons, and a fourway rocker button that both sets the
recording volume and zooms the 35mmto-70mm (35mm camera equivalent),
fixed-focus, f-2.4 lens. In playback
mode, the rocker button controls the
volume and navigates through recorded
video segments. Two AA batteries are
needed to power about two hours of

combined shooting and playback, both
of which are viewed on a small but bright
1.5-inch color display.
Copying the video files to your Mac
is as easy as popping out the built-in
USB 2.0 plug and connecting it to an
available USB port on your Mac. The
Point & Shoot has 512MB of internal
memory capable of storing 30 minutes
of video, and unfortunately, there’s no
memory-card slot so you can store more
videos. What we first thought was a
slot for a memory card turned out to be
a port that allows connection to a DVD
burner—Pure Digital encourages you
to drop the camera off at an authorized
retailer, where a DVD of your movies is
burned in an hour for about $10 to $13.
A list of nearby retailers is available at
www.puredigitalinc.com/retailers.html.
The Point & Shoot comes with Mac
software that you can use to view the
camcorder’s movies while the device is

connected to your Mac. You can bypass
the software and transfer the video files
directly to your hard drive (the camera
appears as a storage device on your
Desktop), but the movies are recorded in
AVI format, which will choke QuickTime
Player—Pure Digital’s QuickTime AVI
plug-in worked sporadically. We did have
success with RealPlayer 10 for Mac OS
X (free, www.realplayer.com) and DivX
Player 1.0.3 (free, www.divx.com). If you
intend to email AVI files to other Mac
users, they may have to download one
of these players to view the movie. If you
want to use the AVI files in iMovie HD,
you need to convert them using software
such as Flip4Mac’s WMV Player Pro ($29,
www.flip4mac.com) to a format iMovie
HD can read.
We weren’t expecting to record stellarquality video, but when we connected
the camcorder to a large TV (cables are
included) and viewed our clips, we were

PodSwap

iPod Mounting Solutions

iPod Showcase
Banshee Listening Station

The only 5.0 surround system in
a single listening station.

Shatter the perceived limitations of
audio for your iPod with a massive
50 watts of peak output power. The
Banshee’s patented technology
produces ultracrisp midranges with
deep and powerful bass. Available
at RadioShack, select Circuit City
stores, Discovery Channel Stores,
and Chicago-area Abt Electronics
locations.
www.BansheeAudio.com
312-474-6108

Owning an iPod can be more
affordable than you think.
Purchase new or “PodSwap
Certified” used iPods.

Get cash or instant credit for your
used or broken iPod. We guarantee
everything we sell and pay fair
prices for used or broken iPods.
One stop does it all. Let PodSwap
expand your options.
www.PodSwap.com

Advertisement

Taking your music with you
is even easier with ProClip!

ProClip mounting solutions are
the best way to mount your iPod in
your vehicle. The mount clips on in
seconds without interior damage.
For details on ProClip mounting
solutions for your iPod as well
as your other devices, visit:
www.proclipusa.com
800-296-3212

REVIEWS

Easier to
carry than
your typical
camcorder.
Connects to
your Mac’s USB
port.

impressed. The Point & Shoot records at
30 frames per second, so we got goodlooking motion, and the Point & Shoot’s
640-by-480-pixel video resolution
COMPANY: Pure Digital
CONTACT: 415-445-7626,
www.puredigitalinc.com
PRICE: $129.99

REQUIREMENTS:
Mac OS X, USB

(with millions of colors) was more than
adequate for TV viewing. If you have an
HDTV, you won’t see an improvement
in quality; you’d need a true HD video

camcorder for that. The camcorder’s
minuscule internal speaker produces
tinny sound, but the TV reproduced the
audio nicely. The only disappointment
was that the focus softens if objects are
closer than three feet.
During recording, a counter blinks
away in the upper-left corner of the LCD
to show elapsed time in minutes and
seconds. Unfortunately, it also appears
when videos are played back on a TV,
obscuring the picture. There’s also no
way to pause or to go back to a section of
the clip without going to the beginning.
However, when we played our movie files
on a Mac, the time counter disappeared.
The bottom line. Aside from everyday
moviemaking, the Point & Shoot is
perfect for hidden-camera shenanigans,
kite-tethered aerial filming, mounting
on dirt bikes or skateboards, and
spontaneous video recording.
—Arthur Bleich

GOOD NEWS: Inexpensive. Full 30 frames per second for excellent motion.
Pocket sized. Ridiculously easy to use.
BAD NEWS: No memory-card option. Abbreviated functions during TV
playback. Focus goes soft on extreme close-ups. Warranty is for only 90 days.

iPod Showcase
Elite Audio Gear

iPod Music Liberator

Icuiti iWear

Liberate your music.

6i Isolator Earphones deliver
detail, balance, comfort,
and value.

The in-ear secure fit reduces
background noise so you can listen
at safe levels. Hear crisp, clear
music inside your head. Great for
travel and working out. Available
online or at Apple Stores and other
retail locations worldwide.
www.etymotic.com

The iPod Music Liberator lets you
copy music, videos, playlists, and
ratings from your iPod to your
computer, a key feature missing from
iTunes. With the iPod Music Liberator
you can recover music from your
iPod if your computer crashes,
make a backup of your music, and
move music to another authorized
computer. If you have an iPod, you
need the Music Liberator. Visit our
site and email us the code A816 for a
chance to win an iPod nano!
zeleksoftware.com/liberator.htm

Advertisement

See the big picture with
Icuiti’s iWear.

iWear is a personal big-screen
display that will transform your
small 2-inch screen into a large,
private 35-inch home theater.
It attaches to and draws power
from the iPod’s bottom dock
connector and is worn like a pair
of sunglasses.
www.icuiti.com
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COMING SOON

When Cold
Wars Heat Up

H

earts of Iron II: Doomsday is
an expansion pack for the
popular World War II real-time
strategy game Hearts of Iron II.
The pack continues the war past
1945, with the Western Allies
and the Soviets squaring off.
Doomsday takes a realistic look
at WWIII with over 10 playable
war-torn nations going into a new
conflict, political and resource
maneuvering, heightened tension
in China, and nuclear scenarios.
Use spies to steal technology,
sabotage research and factories,
assassinate leaders, and even
encourage revolutions. Doomsday
also comes with a new scenario
editor for your own alternative
timeline.—Matt Osborn

And to think, there
was a time when
this was a possible
reality. Scary.

HEARTS OF IRON II:
DOOMSDAY

DEV/PUB: Virtual Programming, www.vpltd.com
AVAILABLE: Now ■ PRICE: $24.95

TIPS & TRICKS

Colin McRae Rally Mac Tips
Colin McRae Rally Mac (price TBD, www.feralinteractive.com) is an off-road rally-racing game in which you hone your drift turns and
steering tactics on more than 300 tracks. Try these tips to climb up the ranks, or you may get run off the road.—MO
• Look for opportunities to drive straight instead of turning—it’s faster. Use the hand brake if you swing into a sharp turn.
• For a subtle slowdown, try briefly maneuvering two wheels on a patch of grass.
• Check the weather and road conditions on the stage and adjust your tires before the race; you’ll
be ready for sudden downpours, especially in the UK races.
• Try to have more speed coming out of a turn than going in. Do this by
slowing down before the turn and drift-turning while gaining
traction, and then hit the accelerator.

“You did get the
optional renter’s
insurance, right?”
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iPOD GAMES

Portable Casual Games
The iPod’s nine new games (which require a video-capable iPod running version 1.2 of the iPod software) won’t tempt you to replace
your PlayStation Portable or any other dedicated handheld gaming console, but they’ll help keep you from getting bored stiff while
waiting for the bus. The games are designed for the iPod’s clickwheel, and we’ve rated each one as Easy, Medium, or Hard to reflect
the difficulty of adapting to the clickwheel control. Each game is available only via the iTunes Store for $4.99, or together as a ninepack for $44.91.—Roman Loyola

Bejeweled

Mini Golf

Texas Hold ’Em

DEVELOPER: PopCap Games
OBJECT: Match three or more jewels by

DEVELOPER: Electronic Arts
OBJECT: It’s miniature golf on your ’Pod.
CLICKWHEEL CONTROL: Hard

DEVELOPER: Apple
OBJECT: If you didn’t know that this is a

swapping adjacent jewels.
CLICKWHEEL CONTROL: Easy
Fun game, but scrolling through each row
to select a jewel feels inefficient.

The courses are challenging, but this
game requires precision that’s difficult
to achieve with the clickwheel.

version of poker, you need to get out more
often. Or at least watch more cable TV.
CLICKWHEEL CONTROL: Easy
Get past the hokey graphics and you’ll
satisfy your jones for Texas Hold ’Em.

RATING:

RATING:

RATING:

SOLID

SOLID

GREAT

Cubis 2

Pac-Man

DEVELOPER: Fresh Games
OBJECT: Quickly clear cubes from the

DEVELOPER: Namco
OBJECT: Eat dots, avoid Blinky, Pinky,

board by lining up three or more similarly
colored adjacent cubes.
CLICKWHEEL CONTROL: Easy
The controls feel natural in this addicting
puzzle game.

Inky, and Clyde.

CLICKWHEEL CONTROL: Easy

CLICKWHEEL CONTROL: Medium
All the Pac-Man goodness you expect—
just try not to get frustrated as you adapt
to using the clickwheel for control.

Vortex relies on touch more than strategy,
which some may find boring. Perhaps the
best use of the clickwheel in a game.

RATING:

RATING:

AWESOME

Mahjong

Vortex

SOLID

Tetris

DEVELOPER: Apple
OBJECT: Breakout-style game where you

eliminate blocks with a ball.

RATING:

GREAT

Zuma

DEVELOPER: PopCap Games
OBJECT: Guard your skull by firing colored

clear the board.

falling blocks of different shapes.

CLICKWHEEL CONTROL: Medium

CLICKWHEEL CONTROL: Hard

It’s nothing like traditional Mahjong.
This game essentially tests your ability
to scroll and click as fast as you can.

Still addicting, but the clickwheel
controls don’t feel natural—and they
can be too sensitive.

balls at an advancing string of balls;
when the colors match, the attacking
balls disappear.
CLICKWHEEL CONTROL: Medium
It takes practice to get the precise touch
you need for this game, but thankfully,
Zuma is well paced and addictive.

RATING:

RATING:

RATING:

DEVELOPER: Electronic Arts
OBJECT: Match digital Mahjong pieces to
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DEVELOPER: Electronic Arts
OBJECT: Create horizontal lines using

SOLID

AWESOME
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because inquiring minds have the right to be inspired
iTunes recognize it as an audiobook.
As we write this, the new iTunes 7.0.1
acknowledged our renamed M4B files
as audiobooks, but we’ve heard reports
that some audiobooks may need to be
removed from the iTunes library and
reimported to appear as audiobooks.

AUDIOBOOK CDS TO iPOD
I have several audiobooks that are on
CDs. How do I convert them to files that
I can play on my iPod?
Making audiobook files is easy if you
know the secret. Insert your CD and
select it in iTunes’ Source list; if the
tracks are out of order, click the Name
column header to sort them sequentially
(bonus tip: make sure the little triangle
is pointing up; down sorts in reverse
order). Press Command-A (or click
and drag) to select all of the tracks.
Select Advanced > Join CD Tracks from
the menubar, then select iTunes >
Preferences > Advanced, set the Import
Using pull-down menu to AAC Encoder,
tweak the quality settings if you like (the
Spoken Podcast setting is usually good
for audiobooks), and press OK. Now click
iTunes’ Import button at the upper-right
(or lower-right in iTunes 7) to import
the lot as one big file. iTunes 6.x users
can simply find the file (Control-click
the track you just imported into iTunes
and select Show In Finder), highlight
the file, press Return, and change its
extension from M4A to M4B to have

Harry Potter can’t make iTunes audiobooksavvy, but you can.

STICKY FINGERS
Is there a way to disable the keyboard
on my PowerBook while my kid watches
DVDs on it?
After searching far and wide, we
couldn’t find a solution to this simple
request—but we did find an easy
workaround. The first keys you need
to worry about are the F-keys, which
launch Exposé and Dashboard when
pressed; open System Preferences’
Dashboard & Exposé pane and clear
each item’s keyboard activator by
selecting the dash mark at the bottom
of the pull-down menu. If you’ve set
any custom F-key behaviors, open the

you’ve got 11 channels available within
that frequency, so changing your Wi-Fi
router’s channel should set things right.

WHAM, BAM, ZAP
THE PRAM
Apple
AIR TRAFFIC
calls that status
CONTROL
window thingy
the
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Area. phone, and
Help!
I got Display
a new cordless
every time
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Hey,
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wouldsignal
enable
network
takesFlip4Mac
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my
Mac to play Windows Media video
whatsoever.
fi
les, but
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Many
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use work—liar!
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used by modern
Wi-Fi,that
and
Oops;
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to mention
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playon”
nice.
Flip4Mac
“working
itsFortunately,
Universal
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Keyboard & Mouse preferences pane
and disable any F-key shortcuts or other
global shortcuts that you’ve set. Finally,
to account for DVD Player’s playback
controls (play/pause via the spacebar
and navigation via the arrow keys), open
System Preferences’ Universal Access
pane, click the Keyboard tab, click the
radio button to turn on Slow Keys, and
crank the Acceptance Delay slider all
the way to Long—now Junior will have to
press and hold keyboard keys for about
a minute to interrupt the DVD action.

Please settle this office bet: When
resetting
a Mac’sJACK
PRAM, is a cold start
SNAP BACK,
really
or can
justarrow
restart
What’srequired,
up with the
littlewe
curvy
the
Mac?
on the
right side of the iTunes status
Plenty
know-it-all types say it doesn’t
windowofthingy?
matter,
but Apple’s
party line
is to shut
That’s actually
a snapback
icon—
down
the Mac,
then
start URL
it cold
and
recognize
it from
Safari’s
bar?
Click
hold
downthe
thecurrently
PRAM-zapping
it to bring
playingkeys
song to
(Option-Command-P-R).
the top of your browser window. Bonus:

Bonus: Slow Keys has incredible practicaljoke potential.

MOVIE SAVER
I have a large AVI movie that I’d like to
use as a screen saver. Can you help me
make that happen?
Darn tootin’ we can help you turn
your movies into screen savers. Just
grab a copy of SaveHollywood (free,
http://s.sudre.free.fr) and drop it in
your /Library/Screen Savers folder.
Then launch System Preferences >
Desktop & Screen Saver and click
the Screen Savers tab. Finally, select
SaveHollywood from the list and click
Options to set it up.

ACE MYSPACE
As I browse through the many profiles
on www.myspace.com I am constantly
greeted with large, invasive videos that
sometimes don’t even work! Can I make
them go away?
Choose Safari > Preferences, click the
Security tab, and uncheck the box labeled
Enable Plug-ins to disable the QuickTime
plug-in and all those inane MySpace
vids. Firefox users, disable JavaScript via
Firefox > Preferences > Web Features.

MATH IS HARD
I’m sick of fighting with my boss about

DIFFICULTY
RATINGS

No whining—
anyone
can do this!

It’ll take some
effort, but you
can do it.

This stuff’s
for the pros.
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BAD HOST! BAD!
I’ve been experimenting with SSH on my
remote server, and all of a sudden it says “bad
host” or something—what gives?
You’ve just met the security behind the SSH,
or Secure (Socket) Shell protocol: matchedkey RSA encryption. When you log in to a
server via SSH, the server identifies itself
to your system and establishes matching
encryption algorithms on both ends of the
conduit—or the SSH tunnel, as the hipster
system administrators call it. If either end of
the tunnel gets messed up or updated, the next
time you try connecting to the server it’ll warn
you that it’s an unknown server, and if you’re
using Mac OS 10.3.x, it’ll leave you hanging,
which sounds like your situation; Mac OS 10.4
smartened up the SSH tunneling to accept a
new identifier from a formerly known server.
Since this month’s lesson is pretty easy,
we’ll give you some bonus knowledge: RSA
isn’t an acronym; the protocol is named for
its inventors, Ron Rivest, Adi Shamir, and
Leonard Adleman.

SECURE FTP
FTP is still an excellent way to move files from your Mac to a remote
server or vice versa, and you can add an s to route your FTP session
through a SSH-style secure shell. SFTP works similarly to FTP, using the
following syntax: sftp nikbot@www.macaddict.com: /path/to/
remoteﬁle.zip /pathto/local/ﬁle.zip
This downloads a file (remotefile.zip) from the server (macaddict.com) and
saves that file according to the file path and file name you use in place of
our example. Since you’re creating the file on your local Mac, you can name
it whatever you like, and this is secure FTP, so naturally you’ll be prompted
for a password. As always, learn more about this handy tool by typing man
ssh in a Terminal window and pressing Return.

HOMEiWEBPAGE?

SaveHollywood is way easier to use and
more versatile than its name implies.

I have a huge sprawling mess of a .Mac
HomePage site. If I upgrade to iWeb,
can I import my HomePage pages into
iWeb to update them?
Nope, sorry. iWeb and HomePage speak
entirely different dialects of Web, and
there’s no translator. But both types
of sites can coexist happily on your
.Mac space—and you can even link
them together. To add iWeb pages to
your HomePage index, log in to
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You’re sitting pretty with 300KB—also
known as 2.4Mb.

Don’t you
wish finding
your car keys
was as easy
as finding a
server’s RSA
key?

Mac.com and enter the HomePage
section. Then open your Site Menu page
(or create one if you need to), press
the plus sign to add a menu item, then
click the Edit Link button and enter the
address of your iWeb (or other) page.
You can reciprocate the link on your
iWeb pages via the Link Inspector.

If you want more integration, you’ll have
to rebuild the HomePage site in iWeb.
Niko Coucouvanis never met a Mac he couldn’t
beat into submission, yet he knows that one
will someday replace him.

Submit

technical questions
or helpful tips
directly via email (askus@macaddict
.com) or c/o MacAddict, 4000 Shoreline
Ct., Ste. 400, South San Francisco, CA
December 2006
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make a stop-motion video with iStopMotion

Make a Stop-Motion Video
with iStopMotion
by Brian Moore
WHAT YOU NEED
iStopMotion ($39.95, on the
Disc or www.istopmotion.com)
A compatible video camera,
such as an iSight (built-in on
most new Macs, or $149,
www.apple.com)
Patience, Grasshopper,
patience

Main Viewing
Window, aka
the stage.

Standard
shuttle
controls.

Scrub through
The premise of stop-motion animation
the whole
is simple: Take a picture, move your
project in the
character, take another picture, move
Frame Viewer.
your character again, rinse and repeat,
and then put all of your pictures
together as frames into a video that
shows your character moving. With
Preview Overlay: Slide
some patience, a camera, and a little
this slider to crossfade
help from Boinx Software’s
between what you’ve
ON THE
iStopMotion, making your
captured and the live
DISC
own Gumby-like animation is
video feed.
iStopMotion 1.10.1
nothing but fun.

1

70

Set the Stage

2

Blinking:
Quickly
toggle
the view
between
adjacent
frames.

Onion
Skinning:
View the
current scene
in context
with previous
shots.

Use Display
Mode to
tweak the
transparency
of onionskinned
frames.

Prepare the Shoot

Preparation is the key to any filmmaking project, so get
your ducks (or action figures, in our case) in a row before
you pick up the camera. Choose actors and props that can stand
on their own without any human intervention, such as an action
figure or a clay person—easy posability is also key. A well-lit and
static set is best for stop-motion. If you use natural light coming
in the windows, the scene’s lighting and shadows will change
throughout the capturing process (which can add a cool effect
if you’re into that). Finally, create a compelling story (we’ll leave
that part to you) and write down an outline of what you’re going
to do in your video so you don’t get lost. Stop-motion takes a
long time to
complete,
and once you
get into a
project, you’ll
probably have
to start over
if you change
your plan.

Connect your FireWire video camera or iSight to your
Mac; Boinx provides a Still Camera Plug-in ($20) for
the videoless. Launch iStopMotion, and if the New Movie
dialog doesn’t appear, select Command-N (or File > New) to
set the resolution (Width and Height, measured in pixels) and
Framerate (measured in FPS, or frames per second) of your
video. Click the little camera icon to pick up your camera’s
native resolution, or pick a preset size from the pull-down
menu, or simply type your desired dimensions into the
appropriate fields. When setting the framerate, keep in mind
that more frames per second makes for a smoother animation,
but also
means that
you’ll have to
fill that many
more frames
to make a
second of
footage. Click
OK and you’re
ready to roll.

Their expressions may seem blank when standing still, but with
your expert directing, they’ll surely become Oscar nominees.

Choose a preset, or click the camera icon to use
your camera’s native resolution.
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He was a hardworking farm boy.
She was an Italian supermodel.
He knew he would have just
one chance to impress her.
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have made it their language tool of choice. That’s also why we can back it with a 6-month money-back guarantee.

Speak

Speech-recognition tools compare your pronunciation with a
native speaker.

Listen

Native speakers and everyday language develop your listening
comprehension skills naturally.

Read

Build your reading skills by linking written language to real-life
objects, actions, and ideas.

Write

Practice writing the new language and receive immediate feedback.

The natural way to learn. Rosetta Stone’s
award-winning Dynamic Immersion™ method
taps the skills you used to master your native
language. By combining real-life images and the
voices of native speakers, you become immersed
in your new language and retain what you learn.

Act now to receive a 10% discount.
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3

Lights, Camera, Action!

Place your camera where it won’t get bumped or jostled
as you work—a tripod is ideal. Beware putting an iSight
on the top of your PowerBook—you could easily jostle the
camera just by advancing frames in the iStopMotion window.
We repeat: A tripod works best, with the added bonus that
you can easily add a cinematic camera pan (pan a tiny bit,
snap a shot, repeat) to the action. Move your actors and props
into position for your first scene and start capturing frames
by pressing the spacebar or clicking the Record button on the
main screen. Once you’ve captured the first frame, move your
character(s) just a bit and capture the second. As you add
frames, you’ll notice the default Onion Skinning feature, which
shows you several frames simultaneously—it’s incredibly
helpful for creating smooth motion, because you can see
exactly where everything is in the previous frame. To slow
down the action for dramatic effect or what have you, press the
number 2, 3,
or 4 on your
keyboard to
capture the
respective
number of
frames in
one shot.

We slid the Onion Skinning slider to the right for a clearer view of
fewer frames than the setting in this how-to’s opening screenshot.

5

Take Your Time, Use Your Tools

In iStopMotion’s Preferences window, you can enable speech
recognition so you can yell from across the room to capture a frame.
72
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Stop-motion animation is a long process that takes
an incredible amount of patience. Take your time
while capturing—one second of misshot footage can take all
day to correct. It’s a good idea to frequently play back what
you’ve captured so far, to make sure everything is flowing
appropriately. If you find a problem, scrub through your movie
in the frame viewer to find the errant frames, and remove them.
You can try reshooting a frame by leaving the playhead in place
of the deleted frame(s) and triggering a new capture—it’s easy
in a low-complexity scene, but more trouble than it’s worth if
your scene
is too busy.

Remember, even at 10 frames per second, a five-minute
film contains thousands of frames.

6

Score a Soundtrack

Now that you’ve completed a full stop-motion
animated video, jazz it up with a soundtrack. The
quick way to score your masterpiece is to select File > Import
Soundtrack and navigate to an audio file on your Mac to play
in the background—but note that you can’t edit the audio in
iStopMotion. Select File > Export To QuickTime to put your video
on the Web, or File > Export To DV for a higher-resolution version
you can put on a DVD. Otherwise, if you’d like to synchronize
your sound more precisely, select File > Export To DV, then open
the DV file in iMovie or Final Cut Pro to line up your audio. Then,
within either of those applications, you can export the video
using QuickTime conversion or send it to iDVD, and share your
work with the world. That’s a wrap!

Editing in a separate video-editing application such as iMovie
gives you more control over your video’s audio track.

Brian Moore has a newfound respect for claymators.

Lighting and shadow problems can sneak up on you,
even in a setting with controlled lighting. The main
problem is when you, or an assistant if you’ve got one, cast
a shadow over the scene and nobody notices until you’ve
shot 200 more frames—and changed the action 200 times.
To minimize shadows from you or anybody working with you,
select iStopMotion > Preferences > Shortcuts and check the box
to enable speech recognition. Now you can speak capture one,
two, three, or four to capture up to four frames at once—better
yet, you can
tweak the
phrase and
yell whatever
you want
to trigger
captures. If
you have a
newer Mac,
you can use
the included
Apple Remote
to capture
frames.

4

Keep Your Eyes Peeled
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tee up your photos

Tee Up Your Photos
by Linda Weber
What You Need
Inkjet printer
Iron-on T-shirt transfer media
(usually available where you buy your
inkjet-printer media)
White cotton or cotton/polyester T-shirt
Hard, heat-resistant surface
Pillowcase
Iron

A

ll right fashionistas,
enough whining and
groaning about the
tacky offerings at
your local T-shirt Hut. We’re
going to show you how to make
custom T-shirts that actually
look cool—to you at least,
because they’ll be plastered
with your own photos and
catchy slogans.

Scissors

ON THE

DISC

Tape measure

MaxFace.gif

Pencil
Sheet of white card stock

1

Prepare the Materials

Gather all the materials listed in the “What You Need”
section above and set up your ironing surface—a metal
tabletop or a board on a table works well. Empty any water from
your iron, plug it in, and preheat it on its highest cotton setting
for at least eight minutes. While your iron is preheating, place
your T-shirt face-up on your surface and flatten it out.

Perfect
for holiday
gifting.

2

Using a pencil or dressmaker’s chalk, lightly mark the
T-shirt in the spot where you’d like the top of the transfer
to go. To figure out where to place your transfer, look at other
T-shirts you own with a similarly sized graphic. For example, the
top of a 4-by-6-inch transfer is usually about 2 to 3 inches below
the seam that joins the collar with the front of the shirt. Next,
measure from the left and right to find the horizontal center of
the shirt and mark that spot.

As they say,
strike while the
iron’s hot—so
gather your
supplies ahead
of time.

3

Figure out where
you want to put your
image—front and
center works.

Design and Test Your Transfer

Open the file that contains the image or text you want to transfer.
Set your Print Quality to Best (or your printer’s equivalent) and
Paper Size to Letter. Your Paper Quality setting depends on the kind
of printer you have; if your printer has a setting specifically for T-shirt
transfers or iron-ons, select that. If not, choose photo-quality media,
special media, or premium media. When in doubt, consult the directions
that come in the transfer-media package.
Once you’ve determined the media-quality setting, you’ll want to flip
your image horizontally before you print. Depending on your printer, you
may be able to flip your image directly through your printer settings; if
not, use an image-editing app such as Adobe Photoshop CS2 or Adobe
Photoshop Elements (iPhoto won’t do the job). Once your image is flipped,
do a test print on regular media; it should look like a mirror image.
74
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The text or image should appear mirrored, siht ekil.
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4

Print the Transfer

When you’re happy with your test-print results, place the
T-shirt transfer media in your printer and print it. (The
transfer media’s backing generally has the manufacturer’s logo
on it; the side you should print on is blank.) Don’t use transfer
sheets that have wrinkled or damaged corners—they can all-tooeasily jam your printer.

Make sure you print on
the plain white front of the
transfer media, not the
logoed back.

6

The Heat Is On

Beginning at the edge of the transfer, iron straight across
from right to left—or left to right—in one pass for about
20 seconds. Be sure to apply firm pressure—and don’t be afraid
to use your body weight. To avoid scorching, keep the iron
moving at an even pace without stopping. After ironing across
once, return your iron to the starting point and make a second
pass parallel to and slightly lower than the first pass, making
sure to overlap a little bit of the area you just covered. For a fullpage transfer, make four or five passes total with your iron. Then,
follow the same process from bottom to top, making overlapping
passes that completely cover the entire transfer area a second
time. Be careful to iron the edges and corners well.

5

Prepare for Ironing

Now you’re ready to iron. First, iron the blank T-shirt
(don’t put the transfer on yet) to remove wrinkles; then
iron the pillowcase. Place the pillowcase on your ironing surface
and put the T-shirt on top of it. Using scissors, trim the transfer,
leaving a quarter-inch around the image; this will prevent the
ink from bleeding onto the fabric when you iron. Next, cut an
L-shaped piece of card stock so that the legs of the L are about 4
inches wide—you’ll use this as a “mask” when ironing. Position
your transfer face-down on the T-shirt. Make sure the center
of the transfer lines
up with the center of
the garment. Place
your card-stock mask
about half an inch
from the transfer to
protect the fabric
that isn’t covered by
the transfer, making
sure not to cover the
edges or corners of the
transfer with the mask.
Stack up your stuff and just add heat.

7

Remove the Backing

Once the transfer is cool to the touch (about two minutes
after you finish ironing), peel off the backing; start at one
corner and use slow, steady pressure. If the backing begins to rip
or tear, move to another corner and start over. Once the backing
is off, you and your T-shirt are ready for the runway.

Steady now—you want
to remove just the
backing, not the image.

Tip: Iron first, quadruple
espresso later.

TIPS AND HARD-WON KNOWLEDGE
• Use an iron that doesn’t have an auto-shutoff setting.
Otherwise, the iron won’t get hot enough to make the transfer
adhere well.
• Never iron on an ironing board (or any soft, padded surface),
glass, granite, concrete, or any heat-sensitive surface.
• Transfers for white T-shirts don’t show up well on dark
fabrics—the “white” areas are actually transparent, so
you’ll get a dark-on-dark design. Special transfer media are
available for transferring images to black or other darkcolored T-shirts.
• Print a practice transfer and try it on an old white pillowcase
or similar piece of fabric before you try transferring to a
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T-shirt, just to make sure you’ve mastered the process.
• Be sure not to iron the margin of your transfer over the
pencil or chalk mark you made—you won’t be able to erase it
later if you do.
• Buy a couple of extra T-shirts the first time out, just in case
you make a mistake.
• Once you’ve taken the backing off, never iron directly over a
transfer—you’ll ruin it.
• Wait 24 hours before washing to give the transfer time to
set, and be sure to wash the T-shirt separately the first time.
• Always turn the T-shirt inside out and machine wash in cold
water using color-safe detergent; never use chlorine bleach.

You should see Linda Weber’s wardrobe.

Here are some important things the transfer-media instructions don’t tell you:

Meet your new toolbox...

Actual Size

Introducing TechTool Protege™, the pocket-sized toolbox for
the Macintosh professional. This tiny flash drive boots directly
into Mac OS X. It includes the full-featured diagnostics and
repair utility TechTool Pro, as well as the disk partitioning
program DiskStudio™. All that, and there’s still room left over
for some of your other utilities as well. Unlike a CD, TechTool
Protege is a read/write device. This means it can be updated
as new versions of Mac OS and the utility programs are
released. In addition, computers will boot faster and programs
will run faster from Protege than from a CD.

With TechTool Protege you can do
the following:
DIAGNOSE MACINTOSH
HARDWARE
DIAGNOSE AND REPAIR HARD
DRIVE PROBLEMS
OPTIMIZE AND DEFRAGMENT
HARD DRIVE VOLUMES

As a Macintosh professional, it’s your job to bring dead
computers back to life. The next time you need to work on
a Macintosh, all you need to do is connect TechTool Protege,
quickly boot the computer from it, and get right to work. No
fumbling around with CDs, portable drives, installers or the
myriad of other items you'd usually need to keep in your
toolbox. TechTool Protege... the ultimate Macintosh toolbox.

REBUILD VOLUME
DIRECTORIES
RECOVER DATA FROM
DAMAGED VOLUMES

800-829-6227 • 707-566-3831 • www.micromat.com
©2006 Micromat, Inc. All rights reserved. TechTool is a registered trademark of Micromat, Inc. TechTool Protege and DiskStudio are trademarks of Micromat, Inc.
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trick out iTunes 7

Trick Out iTunes 7
by Niko Coucouvanis
What You Need
iTunes 7.0.1 (free, www.apple.com)
QuickTime 7.1.3 or later (free, www.apple.com)
Mac OS 10.3.9 or later ($129, www.apple.com)
An ever-growing iTunes library to manage

A
1

Behind its flashy new eye candy, version 7 retains some old iTunes
annoyances—here’s how to work around ’em.

Move Your Movies

Movies aren’t like songs; you might listen to Pantera’s
“Hostile” 18 times a day, but even the most hardcore
David Carradine fan (probably) won’t put that kind of mileage
on the movie Death Race 2000. So we’ll move the movie files
out of our main iTunes library and into another folder or hard
drive. For movies already in your iTunes library, drag the files
from /Users/your user name/Music/iTunes/iTunes Music
(most movies will be in the Movies folder) to another location,
and now when you play a movie in iTunes, it treats the moved
movies as if you had never moved them. The next time you buy a
movie, first open iTunes > Preferences, select the Advanced tab
and click the Change button. Navigate to your new movies folder
and click OK. After buying
your movie(s), go back to the
same place and click Reset
so anything you import or
buy henceforth will go to the
regular iTunes library.
At around 1GB per, feature movies can quickly fill your hard drive.

3

Share a Single iTunes Library

If your problem is too many users rather than too much
media, set iTunes to share one music library amongst
all of a Mac’s user accounts. Quit iTunes and drag your iTunes
Music folder into /Users/Shared/, where every user can access
it. Now from each user account, launch iTunes, open iTunes >
Preferences > Advanced, click Change, and navigate to /Users/
Shared/iTunes Music, or wherever you stashed the library.
Make sure to only
move the iTunes
Music folder, not
its neighbors or
parent folder.

2

Keep ’Em Separated

If diddling with iTunes’ preferences every time you want
to buy a movie is too much hassle, try using a separate
library for your video content. Quit iTunes and then relaunch
the app while holding the Option key. iTunes will prompt you
to select a library or create a new one—click Create Library,
navigate to the volume or folder where you want to keep the
new library, type a name in the Save As box, and click Save.
Henceforth, press Option while launching iTunes to select which
library to load.
Stash your
videos in a
dedicated
video library.

4

The No-Cover Recover

By now you know that iTunes 7’s Get Album Artwork
feature (found in the Advanced menu) doesn’t always
work; here are some tricks and workarounds to artsy up your
music library.
Art à La Carte If you only want art for a song or two, Controlclick the song in your iTunes library and select Get Album Artwork.
ReName That Tune If a song’s name in your library doesn’t
exactly match the song’s name in the iTunes Store, no art for
you. Check the iTunes Store’s nomenclature and use it.
BYO If you need covers for songs that aren’t listed in the iTunes
Store, grab a third-party album-art fetcher; we dig the Album Art
Widget (free, www.liquidx.net), which runs on both PowerPCand Intel-based Macs,
and Fetch Art (free, http://
members.cox.net/afriesen3/
fetchart/), which only runs on
PowerPC Macs.

No Big Black in the iTunes Store? We need to speak to the manager.
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Niko Coucouvanis thinks this whole digital-media
thing will eventually catch on.

s iTunes and its integrated iTunes Store evolve—now
offering feature-length movies alongside the songs, TV
shows, music videos, audiobooks, and podcasts—our
iTunes library is busting at the seams. Unfortunately, there’s
no easy way to divvy up your library to keep different-media
files in different locations—but we’ll show you how to do just
that, along with other tips for managing your collection.
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Visit OWC at Booth #2218

Your Mac's 'Better Half'

Laptop Batteries
Up to 62% more capacity!*
with

batteries by

From $99.95
www.MacSales.com/powerbook

OWC Mercury Elite-AL Pro FW/USB Drives
Single and Dual RAID up to 1.5TB (1500GB). Plug-and-Play.
Ready to transfer at up to 800Mbps .

From $109.99
ADD
PORTS!

www.MacSales.com/storage

miniStack™ V2 Firewire & USB Drives

2006 Circle of
05 Ex

200
4-

20

Gold Hon
ore

www.MacSales.com/ministack

nce
lle
ce

Compact yet powerful with up to 750GB disk space and powered
FireWire and USB2 hubs – the perfect external storage/connectivity
solution for ANY Mac! 80GB to 750GB From $99.95
"Add Your Own Hard Drive" 0GB kits From $54.99

e

1 of just 28!

Serving the Computer Universe since 1988

Visit www.MacSales.com 800.275.4576

Memory

NEW! for Mac Pro

2GB (1GB FBDIMM x 2) Sets

SuperDrive Your Mac
External FireWire/USB2 Solutions From $79.99
for G3/G4/G5
Desktop & Tower Macs From $29.99
for PowerBook G4 From $119.99
for iMac G5 From $129.99
for Mac mini From $119.99
www.MacSales.com/superdrives

The RIGHT memory in stock for Apple Intel®-based Macs.
All OWC memory guaranteed and backed by a LIFETIME
advance replacement warranty.

TRUE APPLE
QUALIFIED
PRODUCT!

From $472.99 each

4GB (2GB FBDIMM x 2) Sets

From $945 each

DDR2 667MHz Upgrade sets for all MacBook & MacBook Pro
models, iMac Intel, Mac mini Core Duo & Solo
Up to 2GB Upgrade Set (1GB x 2)
From $59.00
www.MacSales.com/memory

iPod® Accessories

Batteries Don't let a weak battery get in the way of your groove time.
Increase your capacity up to 150%** with a NuPower iPod Battery!
From $19.99
iPod Batteries

Increase
Capacity

150%

Protection
Prevent
damaging your
investment with
iPod cases.
From $4.99

On The Road
Listen to your tunes
while driving! FM
transmitters.
From $9.95

www.MacSales.com/ipod
* For Apple PowerBook G3 Lombard/Pismo models. Up to 62% more capacity than stock Apple battery.
**For iPod Photo and iPod 4th Generation models. Up to 150% more capacity than stock Apple battery.
MA_12-06 Prices, specifications and availability are subject to change without notice. Items returned within 30 days may be subject to a restocking fee.
No return will be accepted without Return Merchandise Authorization number.
Apple and iPod are registered trademarks of Apple Computer Inc.

ma_1206_catalog.indd 1

Order Now

www.MacSales.com
10/13/06 2:38:15 PM

Adobe®
Creative Suite 2

Wacom®
Intuos3 6x11”

Quark®
QuarkXPress 7

Alias®

Order Today!

Only! $319.95

Only! $189.95

Only! $359.95

Save! $50

Save! 67%

Create Digital Artwork!

Design with the Best!

Save! $560

Maya 8 Unlimited
Save! 85%

Make Amazing Projects!

Become a 3D Animator!

We carry thousands of industry-leading software and hardware products at huge discounts for students, teachers and schools. These special prices
are ONLY for the academic community and are typically $10-$20 lower than most college bookstores! Call or visit us online today and start saving!

Adobe®
Acrobat Pro 8............Save 69%
Photoshop CS 2.........Save 52%
Dreamweaver 8.........Save 53%
Studio 8 ....................Save 71%
FileMaker®
FileMaker Pro 8.5 ...............$149
Corel®
Painter IX.5...........................$95
CorelDRAW Graphics Suite X3 ...$95

M-Audio®
Ableton Live 5 ....................$249
Pro Tools 7 M-Powered ......$149
Keystation 49e Keyboard......$99
Microsoft®
Office 2004 Student/Teacher ....$139
Canopus
ADVC-300 ..........................$429
ADVC-55 ............................$169
ProCoder 2 .........................$249
®

NewTek®
LightWave 3D 9.....................$195
Sibelius®
Sibelius 4.................................$239
Auralia 2.1.................................$89
MakeMusic®
Finale 2007.............................$239
PrintMusic 2006.......................$59

Give us a call anytime! 1-800-294-4035
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Hey Parents!
“You you are eligible to
buy for your students at
home or away at school.”

We’ve got your
(iPod’s) back.
Parts & Accessories for your Mac + iPod

do-it-yourself Mac & iPod Parts
free online FixIt Guides
thousands of parts and upgrades

Mac + iPod Parts & Upgrades

1-866-61-FIXIT

iFixit.com
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MacAddict 3.5˝ X 2.3˝

DATA RECOVERY: 800-440-1904

7 great reasons to choose DriveSavers:
Fast, advanced, proprietary techniques.
All operating systems; Mac, Windows, OS/2,
Netware and UNIX.
� All storage devices including SAN, RAID
and NAS systems.
� Instantly retrieve recovered data
with DataExpress™.
� Recommended and certified by all
hard drive manufacturers.
� Government Contracts
“Restoring Data
� Featured on MacAddict,MacWorld,
and Peace of Mind
CNN, BBC and others.
Since 1985”
�
�

“We Can Save It!”

Visit DriveSavers at www.drivesavers.com

©2006 DRIVESAVERS, INC. 400 BEL MARIN KEYS BLVD., NOVATO, CA 94949 INTL: 415-382-2000
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MEMORY
Lifetime Warranty RAM

ALL MEMORY ON SALE!!!

667 MHz DDR2 ECC for Mac Pro NEW!!
4gb Kit 2x2gb
$789
2gb Kit 2x1gb
389
5300/667 - All Intel Macs
1gb 667 SoDIMM
$109
4200/533 For DualCore G5
4gb Kit 2x2gb
$419
2gb Kit 2x1gb
189
4200/533 Powerbook G4 Hi-Res
1gb 533
$109
3200/400 For Dual Prossesor G5
2gb Kit 2x1gb
$209
1gb Kit 2x512mb
99
2700/333 Powerbook G4
1gb 533
$119
PowerMac G4 PC133
256mb/512mb
$29/$69
The memory market is extremely volatile. Prices are always
changing. Please call or check our web site for current pricing.
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HARD DRIVE SPECIALS
AMAZING DRIVE VALUES!

Serial ATA drives for G5/Mac Pro
750gb 7200rpm 16mb cache
$449
500gb 7200rpm 16mb cache
219
250gb 7200rpm 8mb Cache
89
ATA Drives for G4
320gb 7200rpm 8mb cache
$105
250gb 7200rpm 8mb cache
89
120gb 7200rpm 8mb Cache
79
Serial 2.5” for MacBookPro + Intel Mini
160gb 5400rpm 8mb cache
$179
100gb 7200rpm 8mb cache
169
120gb 5400rpm 8mb cache
139
100gb 5400rpm 8mb Cache
119
2.5 ATA Drives for PwrBks/iBooks/G4 Mini
160gb 5400rpm
$179
120gb 5400rpm
139
100gb 5400rpm
119

MAC TRADE-INS WELCOME!
800 •873 •3726
since
1994
®

11933 Wilshire Boulevard, West LA, CA 90025
Phone: (310) 914-3200 Fax: (310) 966-4433

University & School P.O.’s Welcome.

Ad code 1006-6

Prices subject to change without notice.

MacSolutions.com
www.

.COM
800-462-2160

We’ve got all the memory solutions you need for:

Mac Pro • MacBook Pro • Power Mac
PowerBook • iMac • iBook
eMac • Mac Mini
Samsung memory available!

2gb 667MHz DDR2 ECC FB-DIMM* for Mac Pro NEW!! $379
1gb 667MHz DDR2 ECC FB-DIMM* for Mac Pro NEW!! 189
1gb 5300-667 for MacBookPro/Intel Macs
104
1gb 4200-533 for Dual Core G5
104
1gb 3200-400 for Dual Processor G5
104
1gb 2700-333 for PowerBook G4/iBook G4
109
* FB = Fully Buffered

You need ’em?
We’ve got ’em!
Note: Prices are subject to change. Quantities limited to stock on hand. School P.O.’s welcome.

Mac Shop DEC/06

MA1005

85

vv

t

86
tell us how you really feel

LETTERS

include Web Clip technology,
which will let you create your
own Dashboard widgets from
Web pages.—Max

SAVING GIGS
I am a newly converted Mac
user—thank Mr. Jobs and
the Intel Mac mini for that.
The “iLife to Go” tips (Ask
Us, Sep/06 p60) saved me
gigabytes of storage space
on my anemic primary drive.
I am very appreciative, and
realize this is why I prefer the
Mac over the PC. It would’ve
taken a 256-page book to
explain a simple move like
that in Windows, and when
all was said and done, it
probably still wouldn’t have
worked. One question: Are
there any advantages to
using Mail and Safari over
Thunderbird and Firefox? I
used the Mozilla programs
on my PC and continue
to use them because of
familiarity, but think I may
be missing out on more Mac
goodness.—Rich Plisco
Welcome to the MacAddict
nation! As for your question,
it all comes down to your
personal preference. Mail
integrates nicely with
Address Book, and when
Mac OS 10.5, Leopard,
arrives next spring, Safari will

SIZE MATTERS
Now there’s a 24-inch iMac—
and that’s great—but why not
try making a wall-mountable
45-inch (or bigger) iMac that
would truly be the center of
the living room? Does this
make sense as a logical
progression? Or do you think
Apple will work more toward
integrating with the regular
plasma TVs and receivers
most people are now using
in their homes—such as with
the iTV wireless box? I’d
prefer a giant iMac!
—Brian Hill
Sure, but why stop at 45
inches? Heck, why not 45
feet? Now that’s thinking
different.—Max

COLD COMFORT
My wife carries a portable
2.5-inch 40GB drive back
and forth to work. It worked
fine for about four years,
until one day when it simply
wouldn’t mount. I could hear
the drive spinning, but since
it wouldn’t mount, no utility
could touch it—obviously a
mechanical problem. Then I

Survey Says
Which of
Apple’s
recently
announced
products will
you spend your
hard-earned
cash on?

I made this
for a salon, to
keep the iPods
from running
off. I’d submit
it for Case of
the Month, but
I can’t get it off
the wall!
—David Woods

It looks like a
torture rack! Cool!

remembered reading about
a similar problem years
ago and a seemingly weird
fix to recover the data: the
freezer! I enclosed the drive
in a plastic bag to keep
out moisture and froze it
overnight; in the morning
I let it warm up for several
hours (still in the bag), then
plugged it in and let it run
for about an hour to get it
hot again. Finally, I kept
turning it off and on for

Here are the results of our September 2006 survey. Check
out www.macaddict.com each month for a new online poll.

14% Apple isn’t getting
another dime of mine until I can
drop it on an iPhone.

6%

A bad-arse 8GB
black iPod nano ($249)
A cool, colored
4GB iPod nano ($199)

8%

A 30GB iPod
with video ($249)

29%

The 24foot...er, 24-inch
iMac ($1,999)

14% That sexy little
iPod shuffle ($79)

21% The titanic 80GB
iPod with video ($349)
286 respondents
86
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several minutes to initiate
the mounting sequence.
To my delight, it finally
mounted and ran fine! I was
able to copy all her data to
a new drive. And, of course,
this one goes right in the
trash—it was four years old,
after all.—Doc Swift
Nice save! You may have
read about that driveresuscitation method in
our Jan/05 issue (“Total
Troubleshooting,” p16), in
which we also described
another “extreme” repair
trick: baking your drive in a
350-degree oven.—Max

MAC OS X AND THE
PANZERKORPS
My brother and I recently
came across an interesting
theory online about the
nicknames for the Mac OS
X releases:
no that they’re
named for the Panzerkorps.
24inthere was no tank
Although
or armored fighting vehicle
8 gb (Apple’s name
called0Jaguar
forsMac
hu OS 10.2) in the
Germanf army’s arsenal,
30gwas
there
b a Panther,
followed by the Tiger. After

4gb
8gb

WRITE TO US!

MacAddict, 4000 Shoreline Court, Ste. 400,
South San Francisco, CA 94080
or letters@macaddict.com

FOR SUBSCRIPTION QUERIES:
call (toll-free) 888-771-6222

WIN!

WWII was over and the
German army proceeded
with tank production
once again, they built the
Leopard. So I assert that
Apple’s code names are not
necessarily feline related,
and that these nerds may
have built plastic models
as kids.—Travis
That’s pretty interesting
stuff, Travis. “Tanks” for
sharing!—Max

Win Shure E500PTH
Sound Isolating Earphones!
These ’phones are so nice, we’re offering them twice. Last month’s
prize, Shure’s E500PTH Sound Isolating Earphones ($499, www
.shure.com), was so popular that we’re giving you a second chance
to win these beauties. Each earpiece contains three speakers—a
tweeter and dual woofers—and a detachable Push-to-Hear Control
allows you to mute the sound when you need to deal with the
real world. To win them, just write the best caption to the picture
below—it’s déjà vu all over again! Only one entry per contestant.

iFLY? WI-FLY?
I had an iMac without Intel
chips and everything was
fine. Then I switched to an
Intel iMac and noticed an
interesting phenomenon.
I was wondering: Do your
iMacs attract flies? I walk
away from my iMac for 10
minutes, and it has two
or three flies on it. Any
ideas?—Mike Hoffman
Maybe they just think your
new Mac is sweet.—Max

Entry Form

Write a caption
for this picture.

CONTESTANT INFORMATION
Full Name:
Address:
City:

State:

Zip:

LEGO MY MAC!
My 5-year-old likes LEGOs,
and I like Macs. This laptop
is custom built using
pieces purchased at the
LEGO retail store right next
door to the Apple Store in
the Glendale [California]
Galleria mall. It has a 10inch widescreen “display”
(printed on photo paper)
and a slot-loading “optical
drive” with authentic
cardboard-cutout CD. Total
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FOR CD PROBLEMS:
go to www.futureus-inc.com

Email or telephone:

Is there anything LEGOs
can’t do?

cost: $23 and two hours well
spent with my son. My son
loves it; he even took it to
show-and-tell.—Scott Garcia
Outstanding work! Imagine
what you two esteemed
hardware developers
could accomplish with the
technogoodies on p60!—Max

MNEMONICS CONTEST WINNERS!
Remember our contest (Log Out, Sep/06, p78) for the best
mnemonic device for Apple’s OS X releases (Cheetah, Puma,
Jaguar, Panther, Tiger, and Leopard)? Well, here are the
winners, who will each receive a supercool MacAddict Mini
Maglite. Congrats! And thanks to all who entered.—Max
Computer perfect just prior to lightning.—Dave Aton
Canceled promises justify people trying Leopard.
—Nick Houllis
Charcoal paint jobs pricey to laptops.—Zach Decker
Cheesy Poofs jeopardize peace toward lunacy.
—Michael Hallsted

Send email entries to: contest@macaddict.com with the subject: Shure Contest—Take
Two (Don’t forget to include your address information!) Send snail-mail entries to: Shure
Contest—Take Two, MacAddict magazine, 4000 Shoreline Court, Suite 400, South San
Francisco, CA 94080. Deadline for entry: December 30, 2006. Contest results will appear in
our Apr/07 issue.
Contest Rules The judges will be MacAddict editors and will base their decision on 33 percent humor, 33 percent
originality, and 33 percent creativity. All entries must be received no later than December 30, 2006, with the winner
announced around April 2007. By entering this contest, you agree that Future US, Inc. may use your name, likeness,
and Web site for promotional purposes without further payment. All prizes will be awarded, and no minimum number
of entries is required. If two or more people enter identical winning captions, the entry received first will be awarded
the contest prize. Prizes won by minors will be awarded to their parents or legal guardians. Future US, Inc. is not
responsible for damages or expenses the winners might incur as a result of this contest or the receipt of a prize,
and winners are responsible for income taxes based on the value of the prize received. A list of winners may also be
obtained by sending a stamped, self-addressed envelope to Future US, Inc. c/o MacAddict Contest, 4000 Shoreline
Court, Suite 400, South San Francisco, CA 94080. This contest is limited to residents of the United States. No
purchase necessary; void in Arizona, Maryland, Vermont, Puerto Rico, and where prohibited by law.

Winner!
Congratulations to Todd
Johnson, whose caption won him
a BookEndz Dock for his trusty
iBook G4 ($159.95, www
.bookendzdocks.com)—and better
luck next time to the dozens of you
who submitted firewall jokes.

Undo! Undo! Undo!
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SHUT DOWN

don’t let the back page hit you on the way out

Shufﬂearring?

When Steve Jobs unveiled the tiny new iPod shuffle, he showed
off its built-in clip by attaching it to his trademark jeans while
boasting that it would be the must-have fashion accessory
of the holiday season. Little did he know how true that boast
would become. Recently spotted on the most discerning punks
88

December 2006

and hipsters—whether they’re sucking down ciggies outside
grungy dive bars, waiting in the bathroom line at crowded
warehouse parties, or hunting down the perfect pair of skinny
jeans in their local thrift stores—here’s a glimpse at the future of
musical jewelry.

